
Rational Software Corporation®
Rational® Software
License Management Guide

VERSION: 2003.06.00 

G126-5302-00

WINDOWS
CT25XNA
http://www.rational.com





Legal Notices
©1999-2003, Rational Software Corporation. All rights reserved.

Version Number: 2003.06.00

This manual (the "Work") is protected under the copyright laws of the United States and/or 
other jurisdictions, as well as various international treaties.  Any reproduction or distribution of 
the Work is expressly prohibited without the prior written consent of Rational Software 
Corporation.

The Work is furnished under a license and may be used or copied only in accordance with the 
terms of that license.  Unless specifically allowed under the license, this manual or copies of it 
may not be provided or otherwise made available to any other person.  No title to or ownership 
of the manual is transferred.  Read the license agreement for complete terms.

Rational Software Corporation, Rational, Rational Suite, Rational Suite ContentStudio, Rational 
Apex, Rational Process Workbench, Rational Rose, Rational Summit, Rational Unified process, 
Rational Visual Test, AnalystStudio, ClearCase, ClearCase Attache, ClearCase MultiSite, 
ClearDDTS, ClearGuide, ClearQuest, PerformanceStudio, PureCoverage, Purify, Quantify, 
Requisite, RequisitePro, RUP, SiteCheck, SiteLoad, SoDa, TestFactory, TestFoundation, 
TestMate and TestStudio are registered trademarks of Rational Software Corporation in the 
United States and are trademarks or registered trademarks in other countries.  The Rational 
logo, Connexis, ObjecTime, Rational Developer Network, RDN, ScriptAssure, and XDE, among 
others, are trademarks of Rational Software Corporation in the United States and/or in other 
countries.  All other names are used for identification purposes only and are trademarks or 
registered trademarks of their respective companies.

Portions covered by U.S. Patent Nos. 5,193,180 and 5,335,344 and 5,535,329 and 5,574,898 and 
5,649,200 and 5,675,802 and 5,754,760 and 5,835,701 and 6,049,666 and 6,126,329 and 6,167,534 
and 6,206,584. Additional U.S. Patents and International Patents pending.

U.S. Government Restricted Rights
Licensee agrees that this software and/or documentation is delivered as "commercial computer 
software," a "commercial item," or as "restricted computer software," as those terms are defined 
in DFARS 252.227, DFARS 252.211, FAR 2.101, OR FAR 52.227,  (or any successor provisions 
thereto), whichever is applicable.  The use, duplication, and disclosure of the software and/or 
documentation shall be subject to the terms and conditions set forth in the applicable Rational 
Software Corporation license agreement as provided in DFARS 227.7202, subsection (c) of FAR 
52.227-19, or FAR 52.227-14,  (or any successor provisions thereto), whichever is applicable.

Warranty Disclaimer
This document and its associated software may be used as stated in the underlying license 
agreement.  Except as explicitly stated otherwise in such license agreement, and except to the 
extent prohibited or limited by law from jurisdiction to jurisdiction, Rational Software 
Corporation expressly disclaims all other warranties, express or implied, with respect to the 
media and software product and its documentation, including without limitation, the 
warranties of merchantability , non-infringement, title or fitness for a particular purpose or 
arising from a course of dealing, usage or trade practice, and any warranty against interference 
with Licensee's quiet enjoyment of the product.



Third Party Notices, Code, Licenses, and Acknowledgements
Portions Copyright ©1992-1999, Summit Software Company. All rights reserved.

Microsoft, the Microsoft logo, Active Accessibility, Active Client, Active Desktop, Active 
Directory, ActiveMovie, Active Platform, ActiveStore, ActiveSync, ActiveX, Ask Maxwell, 
Authenticode, AutoSum, BackOffice, the BackOffice logo, bCentral, BizTalk, Bookshelf, 
ClearType, CodeView, DataTips, Developer Studio, Direct3D, DirectAnimation, DirectDraw, 
DirectInput, DirectX, DirectXJ, DoubleSpace, DriveSpace, FrontPage, Funstone, Genuine 
Microsoft Products logo, IntelliEye, the IntelliEye logo, IntelliMirror, IntelliSense, J/Direct, 
JScript, LineShare, Liquid Motion, Mapbase, MapManager, MapPoint, MapVision, Microsoft 
Agent logo, the Microsoft eMbedded Visual Tools logo, the Microsoft Internet Explorer logo, 
the Microsoft Office Compatible logo, Microsoft Press, the Microsoft Press logo, Microsoft 
QuickBasic, MS-DOS, MSDN, NetMeeting, NetShow, the Office logo, Outlook, PhotoDraw, 
PivotChart, PivotTable, PowerPoint, QuickAssembler, QuickShelf, RelayOne, Rushmore, 
SharePoint, SourceSafe, TipWizard, V-Chat, VideoFlash, Visual Basic, the Virtual Basic logo, 
Visual C++, Visual C#, Visual FoxPro, Visual InterDev, Visual J++, Visual SourceSafe, Visual 
Studio, the Visual Studio logo, Vizact, WebBot, WebPIP, Win32, Win32s, Win64, Windows, the 
Windows CE logo, the Windows logo, Windows NT, the Windows Start logo, and XENIX, are 
either trademarks or registered trademarks of Microsoft Corporation in the United States 
and/or in other countries.

Sun, Sun Microsystems, the Sun Logo, Ultra, AnswerBook 2, medialib, OpenBoot, Solaris, Java, 
Java 3D, ShowMe TV, SunForum, SunVTS, SunFDDI, StarOffice, and SunPCi, among others, 
are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other 
countries.

Purify is licensed under Sun Microsystems, Inc., U.S. Patent No. 5,404,499.

Licensee shall not incorporate any GLOBEtrotter software (FLEXlm libraries and utilities) into 
any product or application the primary purpose of which is software license management.

BasicScript is a registered trademark of Summit Software, Inc.

Design Patterns: Elements of Reusable Object-Oriented Software, by Erich Gamma, Richard 
Helm, Ralph Johnson and John Vlissides. Copyright © 1995 by Addison-Wesley Publishing 
Company, Inc. All rights reserved.

Additional legal notices are described in the legal_information.html file that is included in your 
Rational software installation.
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Preface
The Rational Software License Management Guide provides comprehensive information 
about Rational Common Licensing for Rational’s Windows products. It provides you 
with the technical information you need to: 

■ Request and install floating, named-user floating, and node-locked license keys. 

■ Install and configure the Rational license server software on Windows and UNIX 
servers.

■ Troubleshoot problems related to licensing Rational Software products.

This manual is divided into two sections: desktop tasks and administrator tasks. 

■ If you are licensing Rational products on a desktop or using floating licenses from 
a Rational license server, use the desktop licensing section. 

■ If you are the license administrator or a user who manages the license keys, use the 
license administrator section to request permanent license keys, set up the license 
server (if your company has purchased floating licenses), and use advanced 
features. 

Audience

This guide is intended for desktop users and system administrators. This book 
assumes:

■ Desktop users have knowledge of Microsoft Windows and its conventions. 

■ Administrators have knowledge of Microsoft Windows and its conventions as well 
as knowledge of UNIX operating systems, and experience with client-server 
environments.

Other Resources

■ All manuals are available online, either in HTML or PDF format. The online 
manuals are on the Rational Solutions for Windows Online Documentation CD-ROM. 

■ To send feedback about documentation for Rational products, please send e-mail 
to: techpubs@rational.com.
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■ For more information about Rational Software technical publications, see: 
http://www.rational.com/documentation. 

■ For more information on training opportunities, see the Rational University Web 
site: http://www.rational.com/university.

■ For articles, discussion forums, and Web-based training courses on developing 
software with Rational Suite products, join the Rational Developer Network by 
selecting Start > Programs > Rational Suite > Logon to the Rational Developer 
Network.
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Rational Customer Support

When you contact Rational Customer Support, please be prepared to supply the 
following information:

■ Your name, company name, telephone number, and e-mail address

■ Your operating system, version number, and any service packs or patches you 
have applied

■ Product name and release number

■ Your service request number (if you are following up on a previously reported 
problem)

Contacting Rational Customer Support

If you have questions about installing, using, or maintaining this product, contact 
Rational Customer Support as follows:

Contacting Rational Licensing Customer Support

If you have questions about acquiring license keys for your Rational Software 
products, contact Rational Licensing Customer Support as follows:

Your Location Telephone Facsimile E-mail

North America (800) 433-5444
(toll free)

(408) 863-4000
Cupertino, CA

(781) 676-2460
Lexington, MA

support@rational.com 

Europe, Middle 
East, Africa

+31 (0) 20-4546-200
Netherlands

+31 (0) 20-4546-201
Netherlands

support@europe.rational.com 

Asia Pacific +61-2-9419-0111
Australia

+61-2-9419-0123
Australia

support@apac.rational.com 

Your Location Telephone Facsimile E-mail

Asia Pacific +61-2-9419-0111 +61-2-9419-0123 license@apac.rational.com 

Asia Pacific 
(Japan)

+61-2-9419-0111 +61-2-9419-0123 license@japan.rational.com
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Asia Pacific 
(Korea)

 +82-2-556-9420 +82-2-556-9426 license@apac.rational.com

Asia Pacific 
(Mainland China, 
Hong Kong, and 
Taiwan)

+61-2-9419-0111 +61-2-9419-0123 license@china.rational.com

Europe
Middle East
Africa

+31 20 4546 200 +31 20 4546 202 license@europe.rational.com

North American 
(East Coast) and 
South America 

800-433-5444
(toll free, USA only)

+1 (408) 863 4000

781-676-2460 license@rational.com

North America 
(West Coast) and 
Central America

800-433-5444
(toll free, USA only)

+1 (408) 863 4000

408-863-4001 license@rational.com

Your Location Telephone Facsimile E-mail
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1Before Installing License 
Keys
This chapter introduces you to the basic tasks to get your Rational products licensed. 
Table 1 and Table 2 describe common desktop licensing tasks and direct you to the 
correct section and page for instructions. 

Table 1 directs you to procedures for entering, importing, and requesting licenses for 
your Rational products.

Table 1 Getting Started with Rational Common Licensing

To Scenario Task

Get your permanent (or 
Term License Agreement) 
license key. 

Term License Agreement 
means the license key has 
an expiration date built 
into it.

You have purchased a 
node-locked, floating, or 
named-user floating licenses.

Use your License Key Certificate to request 
permanent license keys from AccountLink 
(www.rational.com/accountlink), Rational’s 
web-based license key management tool.

See Requesting License Keys on page 55 for 
more information about AccountLink.

Get your evaluation 
license key.

You want to evaluate a 
Rational product.

Your Rational sales representative sends 
you an evaluation license key.

You have registered at the 
Try-It Center on rational.com 
to evaluate a Rational product.

The Try-It Center on rational.com sends 
you an evaluation license key.

Install node-locked 
license keys on your 
desktop

You must install the 
node-locked license key on 
your computer.

Use the License Key Administrator (LKAD) 
Wizard to install your license keys. The 
LKAD Wizard launches at the end of 
installation or you can open the LKAD 
from the Start Menu under the Rational 
Software folder. See Installing Node-Locked 
License Keys on page 25 for more 
information.
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Table 2 provides page numbers for advanced user tasks that you may have to 
perform; for example, you have to change desktops or you want your desktop to 
request a point product license before a Suite license.

Opening the Rational License Key Administrator (LKAD)

The Rational License Key Administrator (LKAD) is installed with your Rational 
software and with your Rational license server software. This Rational application 
provides an interface to Rational Common Licensing features. Use the LKAD or the 
LKAD Wizard to enter or import license keys and change your license configuration. 

Note:  You must have administrative privileges on the computer before you can enter 
or import license key information in the LKAD and the LKAD Wizard.

Configure your client 
desktop to request 
licenses from the Rational 
license server.

Your administrator either did 
not specify the license server in 
the site definitions file that you 
used to install the product or 
did not give you the license 
server name before you 
installed the product from the 
CD-ROM.

Use the License Key Administrator (LKAD) 
Wizard to install your license keys. The 
LKAD Wizard launches at the end of 
installation or you can open the LKAD 
from the Start Menu under the Rational 
Software folder. See Configuring Desktops to 
Use Floating License Keys on page 29.

Table 1 Getting Started with Rational Common Licensing (continued)

To Scenario Task

Table 2 Additional Desktop Tasks

To See

Change the order in which Rational 
products use licenses.

Changing License Usage Order on page 35.

Move or return license keys. Returning or Moving Keys for Desktop Users on 
page 37.

Use license floating keys for home or 
travel.

Using Floating License Keys for Home Use or Travel 
on page 33.

Configure UNIX Clients. See the Rational product installation guide or 
Rational Suite Installation Guide for UNIX. To 
configure a UNIX license server for Windows 
clients, see Configuring a Rational UNIX License 
Server on page 81.
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■ To access the LKAD and the LKAD Wizard on a desktop or server, click Start > 
Programs > Rational Software  > Rational License Key Administrator.

■ To access the LKAD and the LKAD Wizard on the Rational license server, click 
Start > Programs > Rational Software > Rational License Server > Rational License 
Key Administrator.

To access the Help, click Help in the License Key Administrator’s main menu, click 
Help in the LKAD Wizard dialog box, or open 
<Install Path>\Rational\Common\licadmin.hlp.

Administrator Privileges for the LKAD

You must have certain administrative privileges to complete tasks in the License Key 
Administrator (LKAD). If you cannot perform a task in the LKAD, it might mean you 
are missing local administrative privileges on that computer. Grayed out menu 
options in the LKAD Wizard, menu bar, or button bar indicate limited privileges. 

1 To see which privileges are missing, select Help > About Rational License Key 
Administrator. You will see one or more of the following statements.

.

2 Request the missing Windows administrator privileges from your system 
administrator.

Statement Explanation

Cannot write to HKEY_LOCAL_MACHINE in 
the Windows Registry.

You cannot specify a license server.

Cannot Start and Stop a Windows Service. You cannot start the license server.

Cannot create a file. You cannot import a license key file on 
to your computer.

Cannot modify a file. You cannot enter a temporary license 
key in your computer.
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2Installing Node-Locked 
License Keys
This chapter describes how to install permanent, term license agreement, and 
temporary node-locked license keys on desktops. A node-locked license key is created 
for a specific desktop and does not require a license server. They allow for portability, 
especially for customers who have isolated computers or laptops. For more 
information about license types and license key types, see License Types on page 46.

■ If you are a desktop user and need to use floating or named-user floating license 
keys, see Configuring Desktops to Use Floating License Keys on page 29.

■ If you are the license administrator and need to install the floating or named-user 
license keys on a Rational license server, see Configuring a Rational Windows License 
Server on page 61 or Configuring a Rational UNIX License Server on page 81.

Opening the License Key Administrator (LKAD)

There are two methods for opening the LKAD and LKAD Wizard:

■ After the product installation is complete, launch the LKAD Wizard and the 
LKAD. The LKAD main window and the LKAD Wizard dialog box appear.

■ Click Start > Programs > Rational Software > Rational License Key Administrator. 
The LKAD main window and the LKAD Wizard dialog box appear.

Reviewing Your License Information in the LKAD

By default, you should see complete information about your license keys in the main 
window of the License Key Administrator. If you do not see this information in the 
window, use the View > Show menu to display information about your licenses.

Table 3 defines each of the options in the View > Show menu.

Table 3 Show Licenses 

License Shows

Invalid and Expired Licenses All expired node-locked, floating, and served licenses 
on the system that you are using
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Installing Permanent or Term License Agreement (TLA) Keys

Request permanent node-locked license keys from AccountLink. Rational sends you a 
permanent license file. This file contains license keys for the desktop that you 
specified in AccountLink. 

Importing Permanent Node-Locked Keys

Use the Rational License Key Administrator (LKAD) or the LKAD Wizard to import 
the license key file on your desktop after you install the Rational product. 

Note:  You must have local administrative privileges for the computer to import the 
license key into the LKAD or LKAD Wizard.

To import a license key file in the LKAD:

1 Select License Keys > Import License Key(s) on the menu bar.

2 In the Import License Key(s) dialog box, find the *.upd or *.txt file (license key 
file) and highlight it.

3 Click Open. The default location for the license key file is 
<Install Path>\Rational\common.

4 Click the Import button in the Confirm Import dialog box.

Other Methods

❑ If your e-mail program supports launching programs from file attachments, 
double-click the .upd or .txt attachment in the e-mail notification you received 
from Rational Software. Select Open it in the Opening Mail Attachment dialog 
box. Click the Import button in the Confirm Import dialog box.

❑ Save the file attachment to any folder and double-click the license file. 

❑ Use the LKAD Wizard.

Floating Licenses All floating licenses on the system that you are using

Node Locked Licenses All node-locked licenses on the desktop that you are 
using

Served Licenses All floating licenses that Rational software on your 
system could request from the license server

Table 3 Show Licenses  (continued)

License Shows
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Entering Temporary or Evaluation License Keys

You can find the license key information for temporary or evaluation licenses in the 
following sources.

■ Your Rational sales representative gives you an evaluation license key. 

■ The Try-It Center on rational.com sends you an evaluation license key.

■ The temporary license key is in your License Key Certificate.

Entering Temporary Node-Locked License Keys

Temporary node-locked license keys can be entered in the LKAD or the LKAD 
Wizard. Launch the LKAD Wizard or the LKAD after installing the product.

Note:  You must have local administrative privileges for the computer to import the 
license key into the LKAD or LKAD Wizard.

To enter license information in the LKAD:

1 Select License Keys > Enter a License in the menu bar of the License Key 
Administrator.

2 Select the type of license.

3 In the next dialog box, enter the following information:

❑ Product

❑ Expiration Date

❑ License Key

❑ Quantity (if you are installing a floating license key)

4 Click Finish. The License Key Administrator adds this information to the license 
key *.dat file in <Install Path>\Rational\common.
Chapter 2 - Installing Node-Locked License Keys – Desktop 27
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3Configuring Desktops to 
Use Floating License 
Keys
Rational products on a Windows desktop can check out floating and named-user 
floating license keys from a Windows or UNIX license server. This chapter explains 
how to specify a license server in your desktop’s License Key Administrator (LKAD). 

In the following four situations, you do not have to open the LKAD and specify the 
license server:

■ Your system administrator has set up a silent installation. The silent installation 
may include a post-installation command that specifies the license server. For 
more information about the silent install command syntax, see the Installation 
Guide for Rational Desktop Products.

■ Your administrator may give you a text file to run from a command window. See 
Running the LKAD Command Line on Windows (Optional) on page 72.

■ Your administrator may have included the license server name in a site definitions 
file in a network release area. When you install the product from the release area, 
you do not have specify the license server in your desktop LKAD. For more 
information about installing Rational products from a release area, see the 
Installation Guide for Rational Desktop Products

■ Your computer is also the Rational license server.

If you have a node-locked license, see Installing Node-Locked License Keys on page 25.

Use Table 4 to guide you through this chapter.

Table 4 Floating License Tasks on Clients

To See

Open the License Key Administrator 
(LKAD).

Opening the License Key Administrator (LKAD) on 
page 30

Configure the client desktop to use a single 
or multiple license servers.

Configuring Desktops to Use Single or Multiple 
License Servers on page 31.

Configure the client desktop to use 
redundant license servers.

Configuring Desktops to Use Redundant License 
Servers on page 31.

Assign a port value in a firewall situation. Entering a Port Value to Support a Firewall on 
page 32.
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Opening the License Key Administrator (LKAD)

You can launch the LKAD after product installation or from the Start menu.

■ After the product installation is complete, launch the LKAD Wizard and the 
LKAD. The LKAD main window and the LKAD Wizard dialog box appear.

■ Click Start > Programs > Rational Software > Rational License Key Administrator. 
The LKAD main window and the LKAD Wizard dialog box appear.

Reviewing Your License Information in the LKAD

By default, you should see complete information about your license keys in the main 
window of the License Key Administrator. If you do not see this information in the 
window, use the View > Show menu to display information about your licenses.

Table 5 defines each of the options in the View > Show menu.

Change the license server search order. Changing the Server Search Order on page 32.

Remove a license server from the search 
order.

■ Removing a License Server from the Server Search 
Order on page 32.

■ Removing the License Server from Your Desktop 
on page 33

Use the License Key Administrator 
command line.

Running the License Key Administrator Command 
Line on page 33.

Use floating license keys when you work at 
home or travel.

Using Floating License Keys for Home Use or Travel 
on page 33.

Table 4 Floating License Tasks on Clients (continued)

To See

Table 5 Show Licenses 

License Shows

Invalid and Expired Licenses All expired node-locked, floating, and served licenses 
on the system that you are using

Floating Licenses All floating licenses on the system that you are using

Node Locked Licenses All node-locked licenses on the desktop that you are 
using
30  Rational Software License Management Guide



Configuring Desktops to Use Rational License Servers

Enter the license server’s host name in the License Key Administrator (LKAD) of your 
desktop. Your license administrator should tell you whether the Rational license 
server has been started before you specify the license server.

Configuring Desktops to Use Single or Multiple License Servers

The following procedure lets you specify one or multiple license servers on your 
desktop. Do not use the following procedure to enter redundant servers. 

To enter the license server hostname(s) on a desktop:

1 Select Settings > Client/Server Configuration.

2 Click Add Server.

3 Single should be the default value next to Server Type. Enter the hostname of the 
license server in the Values column next to Server Name by clicking New-Server. 
Press the Enter key after entering the host name.

Additional Servers

If your system administator has given you the host names of additional license 
servers, click the Add Server button and enter the host name for each server.

4 Click OK after you have entered all servers. 

Your desktop applications request licenses from servers in the order that you enter the 
servers in the LKAD. If you want to change this order, see Changing the Server Search 
Order on page 32.

Configuring Desktops to Use Redundant License Servers

Redundant servers are a system of three servers that work as a team to manage a 
single pool of floating license keys. If one of the servers goes down, the other two 
license servers automatically continue managing the license pool. 

Served Licenses All floating licenses that Rational software on your 
system could request from the license server

Table 5 Show Licenses  (continued)

License Shows
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To enter the redundant license servers on a desktop:

1 Click Settings > Client/Server Configuration.

2 Click Add Server.

3 Click Single next to Server Type. A scroll-down menu should appear. Select 
Redundant in the menu.

4 Enter the Primary, Secondary, and Tertiary license server hostnames in the order in 
which the license administrator requested them in AccountLink. Press the tab key 
to move to the next line.

5 Click OK.

Entering a Port Value to Support a Firewall

Assigning a value to the port in your License Key Administrator is necessary in 
firewall situations. Do not assign a value to this port unless your administrator 
instructs you. To learn more about Rational licensing and firewalls, see Using Floating 
Licenses with a Firewall on page 78. The following procedure assumes the license 
administrator has given you the Rational Vendor port value.

To enter a port value on a desktop:

1 Click Settings > Client/Server Configuration.

2 Enter the value in the Port field.

3 Click OK.

Changing the Server Search Order

Rational applications on your desktop request license keys from the license servers in 
a specific order. This license server list is displayed in the Client/Server dialog box. 

If you would like to change this order, select the license server in the list and click the 
Up or Down button to change its position. Click OK to complete the change.

Removing a License Server from the Server Search Order

If your system administrator tells you that one of the Rational license servers has to go 
offline, you can remove it from the server search order without deleting the 
information from the LKAD. 
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To remove a server from the Server Search Order:

1 Click Settings > Client/Server Configuration.

2 Find the license server in the Search Order list and clear the check box next to it.

3 Click OK.

When the license server goes back online, you can select the check box next to it.

Removing the License Server from Your Desktop

If you know the license server will not be used in the future, remove the server from 
the Client/Server Configuration dialog box by selecting the server name and clicking 
Remove Server.

Running the License Key Administrator Command Line

To automate Rational licensing, your administrator may have you run the Rational 
License Key Administrator from the command window. 

To specify a single, multiple, or redundant license server from the command line:

1 Move the text file that your administrator gives you to any directory. 

2 Open a command window and navigate to that directory.

3 Enter the following command:

licadmin -ffilename.txt
where filename.txt is the text file that contains the license parameter commands. 

The results of running this command are written to the status file filename.txt_STATUS, 
where filename.txt is the name of the license parameter file you created. The status file 
is created in the directory where you executed the licadmin command. 

Using Floating License Keys for Home Use or Travel

The disconnected use mode lets you use Rational software at home within a 3 day 
period of acquiring a floating license key and disconnecting from the network at 
work. Disconnected use of floating licenses on a UNIX license server is not supported.

There are two other options for home use or travel:

■ Depending on whether it is available for your product, you can use node-locked 
keys instead.

■ ClearCase LT provides snapshot views. Snapshot views of your work do not 
require network connectivity; therefore, a license key is not necessary.
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Changing the Disconnect Time-Out to Delay Disconnected Use

If you have a slow network at work, your software automatically goes into 
disconnected use mode if it does not receive a response from the Rational license 
server within 5 seconds. You then see a dialog box that states you are in disconnected 
use mode after the 5 seconds.

Starting with release 2001A, you can change the time-out period before your Rational 
application goes into disconnected use mode. The default setting is 5 seconds. To 
change the setting:

1 Create a DWORD key: HKEY_LOCAL_MACHINE\SOFTWARE\Rational
Software\Licensing\1.0\DisconnectTimeout

2 Modify the value (decimal) to be larger than 5 seconds. 
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4Changing License Usage 
Order
Rational products request licenses in a specific order. If you have a combination of 
node-locked, floating, suite, and point-product license keys in your environment, you 
need to understand this license usage order and how you can change it. To 
understand the explanation in the following sections, you must know the definitions 
of the license types. For more information, see License Types on page 46 and Using 
Point Product Keys and Suite Keys on page 48.

Understanding License Usage Order

A Rational product requests licenses in this order, by default:

1 Node-locked before a floating license. A Rational product requests a node-locked 
license before a floating license regardless of whether it is a Suite or point-product 
license.

2 Suite license before a point-product license. For example, Rational Purify is sold as 
part of a Rational Suite and as a stand-alone product. Among a group of 
node-locked and floating licenses, Purify will request the Rational Suite license 
before it requests a Rational Purify license.

3 Suite license of the last Rational Suite installed.

If you would like to change how your Rational product uses point-product and Suite 
licenses, see Changing License Usage on Your Computer on page 36.

Rational RequisiteWeb and ClearQuest Web

Rational RequisiteWeb and ClearQuest Web require floating licenses. Unlike other 
Rational products, they request the point-product license before the suite license.

Rational Rose

Rational Rose uses a license key for the variant of Rose that you install, or a Rational 
Suite key that includes that Rose variant. A Rational Rose variant cannot run with the 
license key of a different Rose variant. If the Rose variant installed on your desktop is 
not included in the suite license on the Rational license server, you cannot include the 
suite license in the license usage order for that product. 
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Cross-Platform Rational Rose Keys

Rose Enterprise can run with a Rose UNIX license key. You must change the license 
usage on your desktop for Rose Enterprise to run with the Rose UNIX key.

Changing License Usage on Your Computer

To change the order in which a product on your computer requests suite and 
point-product licenses, use the License Key Administrator’s License Usage Mapper. 

Servers and License Usage Order

Use the License Usage Mapper on the clients to change the license usage order. To 
change the order for Web clients, use the License Usage Mapper on the Web servers.

If the Rational license server computer is also a client, the License Usage Mapper 
changes the license usage order for specific user ids on the client or Web server. (See 
Defining the “User” in Rational Common Licensing on page 45 and Changing Your License 
Usage Order on page 36 for more information.) You cannot use the License Usage 
Mapper on the Rational license server to change the order for all clients and user ids.

Changing Your License Usage Order

You can reverse the changes that you have made to the previous settings by clicking 
the Restore to Defaults button in the License Usage Mapping dialog box.

To change the license usage order on your desktop:

1 Select Settings > License Usage Mapper in the menu bar. 

2 In the License Usage Mapping dialog box, make sure the correct product is 
highlighted in the Installed Products box. In the License Usage Order box, the 
check boxes that are selected indicate which licenses the license server can check 
out for this product. 

3 Change the order of licenses in the License Usage Order box by using the Up and 
Down buttons. Ensure the check boxes next to these license are selected.

4 Click OK.

Note:  The license usage order that you set on your computer is tied to your user id. If 
different users log in to your computer with their own user ids, the license usage 
order that you may have changed resets to the default order. The new users can set the 
license usage order for their user ids. Their settings do not affect your settings. 
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5Returning or Moving Keys 
for Desktop Users
If you have to upgrade your license keys or move them to another computer, your 
license administrator has to perform a floating or node-locked license key return 
transaction in AccountLink. Floating and node-locked keys are tied to a computer’s 
host ID. Rational products licensed with these keys will not work until your license 
administrator registers the products to the new computer. 

Removing (Returning) Permanent Node-Locked License Keys

Use the return transaction in AccountLink to update the count of registered products 
in your Rational account (license pool) before you or your license administrator 
requests new license keys.

To return a license key: 

1 Your license administrator performs the return transaction in AccountLink.

2 When you receive the update file from AccountLink, import the file on your old 
desktop. Importing the update file completes the return transaction. For more 
information, see Installing Permanent or Term License Agreement (TLA) Keys on 
page 26.

Note:  Your license administrator can return and import new floating license keys on 
the Rational license server.

Moving Permanent Node-Locked License Keys

Moving a node-locked license key from one desktop to another requires a return 
transaction and a new license key transaction in AccountLink. To help prevent you 
from confusing the license key update file for the old desktop with the license key file 
for the new desktop, ask your license administrator to order license keys for the new 
desktop after you receive the update license key file for the old desktop.

To move a license key from one desktop to another:
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1 Your license administrator performs the return transaction in AccountLink. See 
Removing (Returning) Permanent Node-Locked License Keys on page 37.

2 After you receive the update file from AccountLink, import the file on your 
desktop. Importing the update file completes the return transaction. For more 
information, see Installing Permanent or Term License Agreement (TLA) Keys on 
page 26. 

3 Tell the license administrator to order a new license key file in AccountLink for the 
new desktop.

4 Remove the Rational software from the old desktop. See the Rational Desktop Products 
Installation Guide for the removal procedures.

5 Install the Rational software on the new desktop.

6 Import the license key file on the new desktop. For more information, see Installing 
Permanent or Term License Agreement (TLA) Keys on page 26.

Note:  Your license administrator can return and import new floating license keys on 
the Rational license server.
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6Before Requesting 
License Keys
This chapter describes Rational Common Licensing and supported configurations. 
This information will help you plan the licensing configuration for your environment. 

Getting Started with Rational Common Licensing

Table 7 and Table 8 help you find procedures for administrator licensing tasks.

Table 7 Getting Started with Rational Common Licensing

To See

Understand Rational Common Licensing 
terms.

■ Rational Common Licensing on page 45.
■ Using Point Product Keys and Suite Keys on 

page 48.

Find out which licensing configurations 
Rational supports.

Rational Licensing Configurations on page 52.

Upgrade license keys. Upgrading License Keys on page 51.
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Get the permanent license key for the 
product.

■ If you have purchased node-locked, floating, 
or named-user floating licenses, use your 
License Key Certificate to request permanent 
license keys from AccountLink 
(www.rational.com/accountlink), Rational’s 
Web-based license key management tool. See 
Requesting License Keys on page 55 for more 
information.

■ If there is a delay in receiving your 
permanent node-locked or floating license 
keys, use the temporary license key on the 
License Key Certificate. 

■ Users can enter node-locked keys into the 
Rational License Key Administrator 
(LKAD) on their desktops. See Entering 
Temporary or Evaluation License Keys on 
page 27.

■ You can enter the temporary key from the 
License Key Certificate on a Rational 
license server. Users can configure 
desktops to use the license server. See 
Configuring Desktops to Use Floating License 
Keys on page 29.

Get an evaluation license key for the 
product.

Your Rational sales representative or the Try-It 
Center on rational.com sends you an evaluation 
license key.

Install node-locked license keys on your 
desktop

Installing Node-Locked License Keys on page 25.

Install the floating and named-user 
floating keys on the Rational Windows 
license server.

Configuring a Rational Windows License Server on 
page 61.

Install the floating keys on the Rational 
UNIX license server.

Configuring a Rational UNIX License Server on 
page 81.

Table 7 Getting Started with Rational Common Licensing (continued)

To See
42 Rational Software License Management Guide



Table 8 references additional tasks and information that may suit the needs of your 
users.

Using Your Rational License Key Certificate

Rational Common Licensing requires that you use your Rational License Key 
Certificate to request permanent license keys for your Rational products. You will find 
the certificate enclosed in a large green envelope in your product shipment or you will 
receive a certificate from your Rational sales representative. The information, 
especially the Rational Account Number, on this certificate verifies that your 
company has purchased licenses to run Rational products.

■ To get your permanent or Term License Agreement (TLA) node-locked or floating 
license keys, supply information from your Rational License Key Certificate to 
AccountLink (www.rational.com/accountlink). 

■ If you have purchased a Rational XDE product, the single-string desktop key on 
the License Key Certificate is your permanent license. Do not order a permanent 
license key from AccountLink.

Table 8 Optional or Additional Tasks

To See

Configure Rational redundant license 
servers on Windows servers.

Setting Up Redundant Windows License Servers 
(Optional) on page 77.

Configure Rational redundant license 
servers on UNIX servers.

Setting Up Redundant UNIX Servers (Optional) 
on page 88.

Remove the Rational license server 
software from a Windows server.

Removing the Rational Windows License Server 
Software on page 80.

Remove the Rational license server 
software from a UNIX server.

Removing the Rational UNIX License Server 
Software on page 98.

Use floating license keys for working at 
home or traveling.

Using Floating License Keys for Home Use or 
Travel on page 52.

Combine license files from multiple 
vendors.

Rational and GLOBEtrotter recommend 
keeping the license keys in separate files. 

Understand license installation problems 
and error messages.

■ Administrator Privileges for the LKAD on 
page 23.

■ Troubleshooting Licenses on page 113.

Understand the mechanics of Rational 
Licensing.

Understanding Rational Licensing Components on 
page 103.
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■ To evaluate a Rational product, you do not use a License Key Certificate. A 
Rational sales representative provides an evaluation license key or you receive a 30 
day evaluation key after you register on the Try-It Center at rational.com.

■ If you are unable to access AccountLink to request permanent license keys or there 
is a delay in receiving your permanent keys, enter the temporary license key from 
your License Key Certificate into the Rational License Key Administrator (LKAD).

Opening the Rational License Key Administrator (LKAD)

The Rational License Key Administrator (LKAD) is installed with your Rational 
software and with your Rational license server software. This Rational application 
provides an interface to Rational Common Licensing features. Use the LKAD or the 
LKAD Wizard to enter or import license keys and change your license configuration. 

Note:  You must have administrative privileges on the computer before you can enter 
or import license key information in the LKAD and the LKAD Wizard.

■ To access the LKAD and the LKAD Wizard on a desktop or server, click Start > 
Programs > Rational Software  > Rational License Key Administrator.

■ To access the LKAD and the LKAD Wizard on the Rational license server, click 
Start > Programs > Rational Software > Rational License Server > Rational License 
Key Administrator.

To access the Help, click Help in the License Key Administrator’s main menu, click 
Help in the LKAD Wizard dialog box, or open 
<Install Path>\Rational\Common\licadmin.hlp.

Using the LKAD after Product Installation

The Setup Wizard lets you launch the License Key Administrator (LKAD) and LKAD 
Wizard after the product installation finishes. 

On a desktop, use the LKAD to:

■ Import a node-locked license file.

■ Enter a temporary node-locked license key.

■ Specify a license server to request floating licenses.

■ Go to AccountLink to request permanent license keys.
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On a license server, use the LKAD to:

■ Import a floating or named-user floating license key.

■ Enter a temporary floating license key.

■ Go to AccountLink to request permanent license keys.

Rational Common Licensing

Rational Software uses a software-based license management tool called FLEXlm 
from GLOBEtrotter, Inc. This software allows vendors, such as Rational Software, to 
build a customized licensing model by implementing the FLEXlm features that best 
meet their business needs. 

Defining the “User” in Rational Common Licensing

Rational Common Licensing checks out licenses on behalf of a “user”. The “user” is 
defined as follows:

■ On Windows, the “user” is the Windows operating system log on ID.

■ On UNIX, a “user” is the account name of the person running the UNIX shell.

■ On Web products, the “user” is the product logon ID.
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License Types 

The following table explains types of licenses.
Rational

Table 9 Product License Types

License Type Rational Products Description

Floating All Rational products 
included in Rational 
Common Licensing, 
except XDE products.

■ A license administrator installs 
Rational license server software on 
single, multiple, or redundant servers. 
The administrator then installs the 
floating licenses on the license server. 
These floating licenses are created for 
the specific license server.

■ Desktop users obtain licenses from 
the license server when they run a 
copy of Rational software. One license 
is granted per client per product, 
except performance testing products. 
Performance testing products can 
check out multiple licenses.

■ Floating licenses allow anyone on 
your network to use Rational 
products as long as a license is 
available. Thus, the number of 
licenses that you purchase and 
register in AccountLink determines 
the maximum number of users who 
can use Rational products 
concurrently.

■ A floating license can be a permanent 
license, a term license agreement 
(TLA), or it can be an evaluation 
license.

Note: ClearQuest Web or RequisiteWeb 
servers request floating licenses from the 
Rational license server to run Rational 
ClearQuest Web and Rational 
RequisiteWeb on Web clients.
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License Key Types

Floating or node-locked licenses can be permanent and temporary keys. 

Named-User Floating ■ PureCoverage
■ Purify
■ Quantify

■ Similar to a floating license, except the 
license administrator assigns licenses 
to specific users. That is, only specific 
users can request floating license keys 
from the license server. 

■ A named-user floating license 
requires a license administrator to 
create a list of authorized users. 

■ A named-user license can be a 
permanent license, a term license 
agreement (TLA), or it can be an 
evaluation license.

Node-locked All Rational products 
included in Rational 
Common Licensing, 
except XDE products.

■ A node-locked license is created for a 
specific desktop. It allows a user to 
run a Rational product only on that 
specified desktop.

■ The user may run multiple sessions of 
a Rational product concurrently on 
the specified computer using a single 
license key.

■ Because node-locked licenses are 
uncounted licenses, no license server 
is needed to manage them.

■ A node-locked license can be a 
permanent license, a term license 
agreement (TLA), or it can be an 
evaluation license.

Table 9 Product License Types (continued)

License Type Rational Products Description
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The following table defines the license key types used in Rational licensing. 
.

Using Point Product Keys and Suite Keys

This section explains situations in which products use multiple license keys and in 
which multiple products use one license key.

Using Multiple License Keys

A desktop user can check out multiple floating or node-locked license keys.

Table 10 License Key Types

License Key 
Type

Description

Permanent ■ A license issued to a customer to run Rational products for an 
indefinite period of time. 

■ To order your permanent floating or node-locked license keys, use 
AccountLink at www.rational.com/accountlink. 

Temporary 
(evaluation or 
emergency)

■ A time-limited license issued to a customer for running Rational 
products. You can use it on any computer until the specified expiration 
date.

■ Temporary keys are not generated for a specific computer.
■ Temporary license keys can be floating or node-locked.
■ Temporary keys are generated only for single or multiple license 

servers. They are not generated for redundant servers.

■ To evaluate a Rational product, either ask your sales representative for 
an evaluation key or register for the evaluation on the Try-It Center at 
rational.com and receive an evaluation key from the web site.

TLA (Term 
License 
Agreement)

■ TLAs allow users access to Rational software for a negotiated period of 
time. The expiration date is built into the license key.

■ TLA license keys can be floating or node-locked
■ The processes of requesting and installing floating or node-locked TLA 

license keys are the same as requesting and installing permanent 
licenses. 

■ To order your floating or node-locked TLA license keys, use 
AccountLink at www.rational.com/accountlink.
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Using ClearCase LT

Rational ClearCase LT can use either a ClearCase LT floating license or a Rational 
Suite (node-locked or floating) license. There is no ClearCase LT node-locked license.

Using ClearQuest Web and RequisiteWeb

A single user may run the native ClearQuest client and ClearQuest Web on the same 
desktop simultaneously with a single floating license key as long as the user’s 
Windows login ID is the same as the user’s ClearQuest login ID. The same logic 
applies to Rational RequisitePro client and RequisiteWeb. See Defining the “User” in 
Rational Common Licensing on page 45 for more information.

Using Suite License Keys

A Rational license key indicates whether it is a Rational Suite license, such as Rational 
Suite Enterprise. A Rational license file can contain multiple suite and individual 
product license keys. 

A Rational Suite license key lets you run all of the products contained within a 
Rational Suite at the same time on a single computer. The Rational Suite checks out a 
single floating or node-locked license key. Any add-on product, such as Rational XDE, 
uses its own license key instead of the Rational Suite license key.

Using a Different Suite License from the Suite Edition Installed

You can install a Rational Suite on a desktop and specify that products within the 
Suite check out a different type of Rational Suite license. For example, you can install 
Rational Suite Enterprise on the desktop and have the products within the Rational 
Suite check out a Rational Suite AnalystStudio license from the license server. 

To select a different license for a product, use the License Key Administrator on the 
client desktop. See Changing License Usage Order on page 35 for more information.

Using License Keys for the Rose Variant Installed

Rational Rose uses a license key for the variant of Rose that you install, or a Rational 
Suite key that includes that Rose variant. 

Table 11 License Keys for Rational Rose Variant

Variant Runs with this Variant License Key:

Rose Enterprise Edition ■ Rose Enterprise
■ Rational Suite Enterprise
■ Rational Suite DevelopmentStudio for Windows
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Using License Keys on Different Platforms

Rational Rose can run with license keys specified for different platforms. To do this, 
change the license usage order on your computer. See Rational Rose on page 35 for 
more information.

■ Rational Rose for UNIX runs with a Rational Rose Enterprise for Windows key.

■ Rational Rose Enterprise for Windows runs with a Rational Rose for UNIX key.

Using ClearQuest Multisite License Keys

ClearQuest MultiSite requires both a ClearQuest license and a ClearQuest MultiSite 
license. Any access to a replicated database requires both a ClearQuest and a 
ClearQuest MultiSite license key.

You can calculate the number of ClearQuest MultiSite licenses your site needs by 
determining how many developers will access replicated databases. If all of your 
developers will access replicated databases, you need the same number of ClearQuest 
MultiSite licenses as ClearQuest licenses. If not all developers will access replicated 
databases, you can purchase fewer ClearQuest MultiSite licenses.

For example, a company has two sites, with 20 developers at site A and 5 developers 
at site B. The company has three databases at site A; two of them will be replicated to 
site B and one will not be replicated. Five of the developers at site A will access only 

Rose Modeler Edition ■ Rose Modeler

Rose Professional Data Modeler ■ Rose Data Modeler
■ Rational Suite AnalystStudio

Rose for UNIX ■ Rose for UNIX
■ Rational Suite DevelopmentStudio for UNIX
■ Rose Enterprise for UNIX

Table 11 License Keys for Rational Rose Variant

Variant Runs with this Variant License Key:
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the unreplicated database, and the remaining 15 will work in all databases. All of the 
developers at site B will access replicated databases. Therefore, the company needs to 
purchase the following numbers of licenses:

Note:  This example assumes that you purchase a ClearQuest license for each user. If 
you have fewer ClearQuest licenses than users, you can purchase a proportionate 
number of ClearQuest MultiSite licenses. For example, if site B purchased three 
ClearQuest licenses, they would also purchase three ClearQuest MultiSite licenses.

Upgrading License Keys

If you are upgrading from an earlier version of a Rational Suite or point-product, for 
example 2002.05.00, re-use your current Rational Suite and point-product keys.

The following describe conditions under which you must order new license keys in 
AccountLink:

■ If you have purchased a different edition of Rational Suite from the one you are 
currently using, return the license file and request a new license file that includes 
the new Rational Suite key. 

❑ See Returning or Moving Keys for Desktop Users on page 37 or Returning or 
Moving Keys for Administrators on page 101 for returning the existing key.

❑ See Requesting License Keys on page 55 for requesting permanent or TLA license 
keys.

■ If you are adding a new product to your system, return the license file and request 
a new license file that includes the new product license key. 

❑ See Returning or Moving Keys for Desktop Users on page 37 or Returning or 
Moving Keys for Administrators on page 101 for returning the existing key.

❑ See Requesting License Keys on page 55 for requesting permanent or TLA license 
keys.

■ If you have upgraded to a different variant of Rose, remove the existing variant 
and install the new variant and license key. 

Site Number of ClearQuest Licenses Number of ClearQuest MultiSite Licenses

A 20 15

B 5 5
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Using Floating License Keys for Home Use or Travel

The disconnected use mode lets you use Rational software at home within a 3 day 
period of acquiring a floating license key and disconnecting from the network at 
work. Disconnected use of floating licenses on a UNIX license server is not supported.

There are two other options for home use or travel:

■ Depending on whether it is available for your product, you can use node-locked 
keys instead.

■ ClearCase LT provides snapshot views. Snapshot views of your work do not 
require network connectivity; therefore, a license key is not necessary.

Changing the Disconnect Time-Out to Delay Disconnected Use

If you have a slow network at work, your software automatically goes into 
disconnected use mode if it does not receive a response from the Rational license 
server within 5 seconds. You then see a dialog box that states you are in disconnected 
use mode after the 5 seconds.

Starting with release 2001A, you can change the time-out period before your Rational 
application goes into disconnected use mode. The default setting is 5 seconds. To 
change the setting:

1 Create a DWORD key: HKEY_LOCAL_MACHINE\SOFTWARE\Rational
Software\Licensing\1.0\DisconnectTimeout

2 Modify the value (decimal) to be larger than 5 seconds. 

Rational Licensing Configurations

This section describes licensing configurations supported by Rational Software. The 
term supported refers to a licensing configuration that Rational has tested and 
guarantees will work under normal operating conditions. This applies to 
configurations that the software was designed to handle. This also applies to 
configurations for which the software was not specifically designed, but with which it 
will work with some manual intervention.
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Table 12 lists supported licensing configurations.

Table 12 Rational Licensing Configurations 

Configuration Supported Platforms

Node-locked license key Windows/UNIX

Rational license server and Rational Windows products 
installed on a single computer.

Windows

Rational license server and Rational UNIX products 
installed on a single computer.

UNIX

Floating or named-user floating licenses for Windows 
products

UNIX server serving licenses 
to Windows clients

Permanent floating licenses with redundant license servers Windows server serving 
licenses to UNIX clients

Permanent floating licenses with redundant license servers UNIX server serving licenses 
to UNIX clients
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7Requesting License Keys
Permanent (or Term License Agreement) floating and node-locked license keys are 
managed through the Web tool AccountLink (https://www.rational.com/accountlink). You, 
as the license administrator, can request permanent license keys in AccountLink. 

The information in this chapter is intended for system administrators or users who 
manage licenses. It provides information about requesting and receiving permanent 
floating and node-locked license keys from AccountLink.

Using AccountLink to Request Permanent License Keys

In AccountLink, you can order and return permanent node-locked, floating, and 
named-user floating license keys for Windows and UNIX products. For more 
information about license types, see License Types on page 46.

Note:  AccountLink does not support temporary license key transactions (Contact 
your sales representative.)

AccountLink’s interface offers three license transactions:

1 Get License Key(s) – Request your permanent license key. To order a permanent 
key, you need your Rational License Key Certificate, the host name and host ID, or 
ethernet address of the license server or desktop. 

You can register:

❑ Rational Windows or UNIX products that will be served from a Rational license 
server.

❑ Single, multiple, or redundant Rational license servers on Windows or UNIX 
computers.

❑ Remote Windows or UNIX computers; you do not need to sit at the computer 
you are requesting license keys for.
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To find out more about the host name and host ID, see Finding the HOST ID on 
page 56. To order permanent license keys for a redundant server environment, 
specify the redundant servers’ host IDs in the following order: 

a Primary license server

b Secondary license server

c Tertiary or back up license server

The clients communicate with the redundant servers in that order.

2 Return License Key(s) – Return the existing license key to your Rational account 
and then request a license key for the new desktop or server. This adjusts the count 
of registered products in your account and enables you to receive a license key for 
the new computer. To learn more about returning license keys, see Returning or 
Moving Keys for Administrators on page 101. 

3 Request a Copy of a License File – Get a copy of a license key file for any desktop or 
server that has license keys already registered to it. You need this transaction when 
your hard disk is reformatted, you need to restore the software on your computer, 
or your license keys become corrupt. This transaction does not require that you 
return or add license keys. 

Finding the HOST ID

The term host ID is a generic term that is used to specify the computer’s disk serial 
number or ethernet address (network id).

With Rational Common Licensing, the default HOST ID value on Windows 
computers is the disk serial number of the user’s boot drive. In this case the HOST ID 
field appears as: DISK_SERIAL_NUM=nnnnnnn. Example: 
DISK_SERIAL_NUM=12345678.

The default HOST ID value on UNIX computers is the ethernet address of the system 
written in the format HOSTID=nnnnnnnnnnnn. Do not confuse the format 
HOSTID=nnnnnnnnnnnn with the disk serial number format 
DISK_SERIAL_NUM=nnnnnnnn that is referred to in Rational Software 
documentation, online Help, and AccountLink as the host ID.

Rational does not allow for multiple values of HOST ID to be defined within a single 
key.
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Finding the Host ID on a Windows Computer

To get the hostname, host ID, or ethernet address of a Windows computer, select 
License Keys > Host Data in the Rational License Key Administrator’s menu bar.

Note:  If Rational software is not installed on the license server or client, Rational 
AccountLink provides a tool to help you find this information.

What if the Host ID on My Computer Changes Frequently?

Registering the host ID of the boot drive may not be possible if you have dual boot 
systems, frequently reformat your disks, or ghost your disk images. These processes 
change the host ID of the boot drive. Because the products and license keys are 
registered to a specific host ID, you cannot use your Rational products if the host ID 
changes.

To avoid this situation, use one of the following approaches:

■ Use floating licenses served by a license server with a constant host ID.

■ Use the address of the ethernet card in the computer as a host ID instead.

Note:  You do not need to add this setting if you have installed release 2001 (or 
later) of Rational products and release 2001 (or later) of the Rational license server. 

On Windows computers, the License Key Administrator (LKAD) can be forced to 
use the ethernet address instead of the disk serial number. This will allow the 
LKAD to import the license key file correctly. Add the registry setting 
“UseNIC=TRUE” to HKEY_LOCAL_MACHINE\SOFTWARE\Rational 
Software\Licensing\1.0. 

■ Make sure that when images are created to refresh the computer to keep the disk 
serial number of the boot drive constant.

Finding the Host ID on a UNIX Server

Use one of the following options to find the host ID:

■ If the Rational license server software is installed, use the lmhostid command to 
find the ethernet address of the server. 

■ On Sun computers, the command lmhostid at the prompt returns the value of 
the Sun host ID. 

■ Download the host ID script from AccountLink.
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Requesting License Keys (Without an Internet Connection)

This section summarizes the steps for getting a permanent license key when you do 
not have an internet connection or when Rational AccountLink is unavailable.

1 Find your License Key Certificate in your Rational product shipment. 

Print the license request form. To print the form, either install the Rational product 
and open the license request form in the Rational common directory or find the 
license request form in the Rational Solutions for Windows installation CD-ROM. 
The Chinese, French, German, and Japanese versions of this fax form are in the 
same location.

■ <Rational_directory>\common\License Fax Form - English.htm
■ <cd_drive>\common\License Fax Form - English.htm
■ <Rational_directory>\common\License Fax Form - Chinese.htm
■ <cd_drive>\common\License Fax Form - Chinese.htm
■ <Rational_directory>\common\License Fax Form - French.htm
■ <cd_drive>\common\License Fax Form - French.htm
■ <Rational_directory>\common\License Fax Form - German.htm
■ <cd_drive>\common\License Fax Form - German.htm
■ <Rational_directory>\common\License Fax Form - Japanese.htm
■ <cd_drive>\common\License Fax Form - Japanese.htm

2 Use the License Key Certificate to fill out the form. Make sure that the contact, 
Rational account number, product, licensing, and host information are correct. 
Any errors will cause delays in receiving your license keys.

3 Fax the request to Rational. See Contacting Rational Licensing Customer Support on 
page xvi for phone and fax numbers. 

Call Rational Licensing Support if you cannot use Rational AccountLink or the fax 
form to order your permanent license keys. 

Receiving Permanent License Keys

After you order your keys in AccountLink, Rational generates a license file that 
contains the license key(s). The file is sent through e-mail to the contact e-mail address 
that you designate in AccountLink’s License Contact page.

If you request a permanent license key by fax and you have specified an e-mail 
address in your contact information, you will receive a license key file through e-mail. 
You can copy the permanent license file from the e-mail enabled computer and install 
it on the computer that is not e-mail enabled. 

If you cannot provide an e-mail address, contact Rational Licensing Support. See 
Contacting Rational Licensing Customer Support on page xvi.
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After you receive the license key file:

■ Import the floating or named-user license key file on the license server. For more 
information about importing a license key file on a license server, see Configuring a 
Rational Windows License Server on page 61 or Configuring a Rational UNIX License 
Server on page 81.

■ Import the node-locked license key file on the desktop. See Installing Node-Locked 
License Keys on page 25.
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8Configuring a Rational 
Windows License Server
Floating and named-user licenses let you manage and maintain licenses on single, 
multiple, or redundant license servers.

This chapter describes how to set up and run Rational Windows license servers. The 
information in this chapter is intended for system administrators or users who 
manage licenses. If you are using desktop licenses, see Installing Node-Locked License 
Keys on page 25.

Some of the tasks in Table 13 are not recommended for the casual or novice user. 
Attempt them only if you are familiar with the Windows operating system and 
Rational Common Licensing.
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Setting Up Floating Licenses for Windows Servers

The steps required to set up floating and named-user floating licenses are described in 
Table 13.

Table 13 Guide to Setting Up Floating Licenses for Windows Servers

To Procedures

Set up floating licenses 1 Understand the Rational Common Licensing model. 
See Before Requesting License Keys on page 41.

2 Request and receive permanent license keys. See 
Requesting License Keys on page 55.

3 Make sure your license server and clients can work 
with the network configuration that you have set up. 
See Working with a Supported Network Configuration on 
page 64.

4 Install the Rational license server software on the 
server. See Installing the Rational License Server on a 
Windows Server on page 65.

5 Install the evaluation/temporary or permanent license 
keys on the license server. See Opening the Rational 
License Key Administrator (LKAD) on page 67, Entering 
Temporary Floating License Keys on page 68, or Importing 
Floating License Keys on page 68.

6 Start the license server software. See Starting the 
Rational Windows License Server on page 71.

7 Tell desktop users to specify the Rational license server 
in their desktops.
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Set up named-user floating 
licenses (only applies to Rational 
Purify, Quantify, and 
PureCoverage)

1 Understand the Rational Common Licensing model. 
See Before Requesting License Keys on page 41.

2 Request and receive permanent license keys. See 
Requesting License Keys on page 55.

3 Make sure your license server and clients can work 
with the network configuration that you have set up. 
See Working with a Supported Network Configuration on 
page 64.

4 Install the Rational license server software on the 
server. See Installing the Rational License Server on a 
Windows Server on page 65. 

5 Install the named-user floating license keys on the 
license server. See Opening the Rational License Key 
Administrator (LKAD) on page 67 and Importing 
Named-User License Keys on page 69. If the keys are 
temporary, enter the license key information in the 
LKAD Wizard. You do not have to edit the rational.opt 
file (skip Step 6).

6 Edit the rational.opt file with the names of specific 
users. See Using Floating Keys on a Windows License 
Server on page 68.

7 Start the license server software. See Starting the 
Rational Windows License Server on page 71. 

8 Tell desktop users to specify the Rational license 
servers in their desktops.

Specifying the Rational License 
Server on a Web Servers

See Specifying the License Server on Windows Web Servers on 
page 75.

Using floating licenses with a 
firewall

See Using Floating Licenses with a Firewall on page 78.

Changing the lmgrd port See Changing the lmgrd Port on page 80.

Configure redundant license 
servers

See Setting Up Redundant Windows License Servers 
(Optional) on page 77.

Use License Key Administrator 
commands for configuring license 
servers on desktops

See Running the LKAD Command Line on Windows 
(Optional) on page 72.

Table 13 Guide to Setting Up Floating Licenses for Windows Servers 

To Procedures
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Working with a Supported Network Configuration

This section provides important information about network configurations.

Dial-Up Support

You can use floating licenses with a dial-up network connection that supports a 
constant TCP/IP connection to the Rational license server. All clients must have a 
constant TCP/IP connection to the license server. 

If the dial-up connection is lost while a client has checked out a floating license, the 
server will automatically reclaim the floating license. When the connection is lost, the 
client cannot periodically “talk” to the license server to refresh its license. Because the 
client cannot refresh its license, the Rational product runs for a limited period of time. 
This time period is product dependent.

Change the order in which 
Rational products use licenses.

You cannot use the Rational license server to change the 
license usage order for all clients. Each user will have to 
go into the License Usage Mapper in the client LKAD to 
change it. The order is tied to the user_id. See Changing 
License Usage Order on page 35.

Modify the time-out period. See Modifying the Floating License Time-Out Period on 
page 76.

Monitoring Rational license server 
activity.

See License Monitoring (Optional) on page 78

Upgrading the license server 
software.

You can upgrade the license server software to the most 
current version, but do not run different versions of 
license server software on the same computer.

Running multiple license servers 
on the same server.

Rational and GLOBEtrotter recommend running a 
separate lmgrd instance for each vendor daemon and 
keeping license keys in separate files.

Diagnose problems with the 
Rational license server.

See the following sections:
■ Checking the Windows License Server on page 121
■ Checking the Windows Network Connection on page 122.

Remove the license server 
software.

See Removing the License Server Software on page 80.

Table 13 Guide to Setting Up Floating Licenses for Windows Servers 

To Procedures
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WAN Support

Rational floating licenses can be used over a wide area network if this is in compliance 
with the geographical allowance of the License Agreement.

If you choose to run licenses over a WAN, be aware of how your systems resolve 
hostnames. Rational recommends, but does not require, that you always use the fully 
qualified domain names in the SERVER line and on the clients. This technique tends 
to reduce the number of issues with hostname resolution.

Novell Support

Rational floating licenses can be used in a Novell 5.0 environment that is configured 
with TCP/IP and/or IPX. Rational’s licensing implementation does not support using 
Novell Netware 5.0 or later directly with floating licenses. 

Node-locked licenses with Novell 5.0 are supported.

Installing the Rational License Server on a Windows Server

This section describes how to use the Rational Setup Wizard to install the Rational 
License server software that enables you to flexibly install and manage license keys. 
You do not have to have a license key to operate the Rational license server software.

Before You Install the License Server on a Windows Server

The requirements for installing the Rational license server on a Windows server is 
minimal:

■ The Rational license server runs on Windows operating systems (NT 4.0 or 
higher), except Windows 9x and XP Home computers. 

■ The Windows server must have a C:\ drive.

■ You must have Windows administrator privileges on the local computer.

■ The default TCP/IP port number is 27000.

■ There is no minimum recommended processor, memory, or disk space. 

Note:  Make sure that you have a current backup of your Registry and system 
directories before running the Rational installation program.
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Default Installation Path

The Rational Setup Wizard uses C:\Program Files\Rational as the default installation 
path. If your C:\ drive lacks sufficient free disk space, either specify another drive or 
make space available on the default drive. A C:\ drive must exist on the license server 
regardless of where you install the Rational license server software. 

Using the Rational Setup Wizard

This section describes how to install the Rational license server from the CD-ROM. If 
you would like to install the Rational license server from a release area or set up a 
silent installation, see the instructions in the Rational Server Products Installation Guide. 
The Rational Setup Wizard guides you through the software installation. Click Next to 
launch the installation, and to advance through the following screens.

The installation wizard does not display an error summary. To verify that an 
installation was successful or to understand why it failed, look in the log of 
installation activities. The Rational install.log file is located in your TEMP directory 
(e.g.TEMP=C:\DOCUME~1\<username>\LOCALS~1\Temp or c:\temp\install.log). The 
location of the directory depends on the system environment variable set on the 
machine.

Note:  Interrupting an installation that is in progress may leave your computer in an 
indeterminate state. If you try to close the Rational Setup Wizard window while the 
installation is in progress, you are asked to confirm that you want to exit from the 
incomplete installation.

To install the license server from a CD-ROM image:

1 Log in as a user with administrator rights on the local computer on which you 
want to install the product.

2 Insert the Rational Solutions for Windows Disc 1 into the computer’s CD-ROM drive. 

The Rational Setup Wizard starts automatically.

If autorun is disabled on your computer, click Start  >  Run and enter 
cd_drive: \Setup.exe where drive is the letter of the CD-ROM drive.

3 The Product Selection page lists all products available for installation. Select the 
Rational License Server.

4 The Deployment Method page displays the Enterprise Deployment and Desktop 
Install from CD Image options. Select the Desktop Install from CD Image option.

5 Choose to accept or not to accept the Rational Software license agreement in the 
License Agreement page. To view the Open Source license agreement, select the 
check box View Open Source Agreement.

❑ If you accept the license agreement, the installation Wizard continues. 
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❑ If you do not accept the license agreement, exit the Setup Wizard by clicking 
Cancel and then Finish. When you exit from the Wizard, the Setup Wizard 
makes no visible changes to your computer.

6 The Destination Folder page specifies the directory where you want to install the 
license server software. Click Change to modify the location.

Note:  The installation Wizard requires that all Rational products be installed in the 
same directory.

7 Click Install on the Ready to Install the Program dialog to begin the installation.

8 A Restart Windows page appears if the Rational Setup Wizard needs to restart your 
computer. If files required for the installation are in use during the Rational Setup 
program and if the program needs to install shared components on your computer, 
the Setup Wizard may need to restart your computer. 

Select Restart or Don’t Restart. If you select Don’t Restart, the Wizard reminds you 
that the installation cannot complete until Windows restarts.

After Windows restarts, log on as the same user. If you do not, the installation does 
not complete correctly. The second part of the installation process starts 
automatically after you log on. 

9 When the Rational Setup Wizard Completed dialog appears, we recommend that 
select the Showme the readme file option to review the current information related 
to features and known issues. In addition, you can select the Take me to the 
Rational Developer Network option. Click Finish to complete the installation.

Note:  Install the floating license keys on the license server before you start the license 
server. See Importing Floating License Keys on page 68.

Opening the Rational License Key Administrator (LKAD)

The Rational License Key Administrator (LKAD) is installed with your Rational 
software and with your Rational license server software. This Rational application 
provides an interface to Rational Common Licensing features. Use the LKAD or the 
LKAD Wizard to enter or import license keys and change your license configuration. 

Note:  You must have administrative privileges on the computer before you can enter 
or import license key information in the LKAD and the LKAD Wizard.

■ To access the LKAD and the LKAD Wizard on a desktop or server, click Start > 
Programs > Rational Software  > Rational License Key Administrator.

■ To access the LKAD and the LKAD Wizard on the Rational license server, click 
Start > Programs > Rational Software > Rational License Server > Rational License 
Key Administrator.
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To access the Help, click Help in the License Key Administrator’s main menu, click 
Help in the LKAD Wizard dialog box, or open 
<Install Path>\Rational\Common\licadmin.hlp.

Using Floating Keys on a Windows License Server

This section describes how to import or enter floating license keys on the Rational 
license server.

Importing Floating License Keys

Import the license key file on the license server by using the Rational License Key 
Administrator (LKAD). 

Note:  You must have local administrative privileges for the server before you can 
import the license key into the LKAD.

To import a license key file in the LKAD:

1 Select License Keys > Import License Key(s) on the menu bar.

2 In the Import License Key(s) dialog box, find the *.upd or *.txt file (license key 
file) and highlight it.

3 Click Open. The default location for the license key file is 
<Install Path>\Rational\common.

4 Click the Import button in the Confirm Import dialog box.

Other Methods

❑ If your e-mail program supports launching programs from file attachments, 
double-click the .upd or .txt attachment in the e-mail notification you received 
from Rational Software. Select Open it in the Opening Mail Attachment dialog 
box. Click the Import button in the Confirm Import dialog box.

❑ Save the file attachment to any folder and double-click the license file. 

❑ Use the LKAD Wizard.

Entering Temporary Floating License Keys

You may enter a temporary or evaluation license key on the license server if you are 
evaluating the product or AccountLink is unavailable. 

Note:  You must have local administrative privileges for the server before you can 
enter the license key into the LKAD.

To enter license information in the LKAD:
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1 Select License Keys > Enter a License in the menu bar of the License Key 
Administrator.

2 Select the type of license.

3 In the next dialog box, enter the following information:

❑ Product

❑ Expiration Date

❑ License Key

❑ Quantity (if you are installing a floating license key)

4 Click Finish. The License Key Administrator adds this information to the license 
key *.dat file in <Install Path>\Rational\common.

Using Named-User Keys on a Windows License Server

Named-user license keys behave like floating license keys, except during the import 
process, the License Key Administrator (LKAD) gives you the opportunity to specify 
a user for each license key. You assign a user to a key by editing the rational.opt file. The 
options file locks the floating license key to the user; allowing the user to run Rational 
Purify, Quantify, or PureCoverage on multiple desktops. 

Importing Named-User License Keys

Import the license key file on the license server by using the Rational License Key 
Administrator (LKAD). 

Note:  You must have local administrative privileges for the server before you can 
import the license key into the LKAD.

To import a license key file:

1 Select License Keys > Import License Key(s) on the menu bar.

2 In the Import License Key(s) dialog box, find the *.upd or *.txt file (license key 
file) and highlight it.

3 Click Open. The default location for the license key file is 
<Install Path>\Rational\common.

4 Click the Import button in the Confirm Import dialog box.

5 Edit the Options File (rational.opt). The LKAD provides an options file in which 
you can assign named-user license keys. As soon as you import the license key file, 
the Edit Options File dialog box appears. If you choose to edit the file:
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a The options file automatically appears in a text editor. Follow the instructions 
in the file for the correct syntax in assigning user ids to license keys.

b After you edit the file, save it, and then close the file.

Note:  You can edit the options file while the license server is running, but stop and 
start the Rational license server after you have edited the file. See Starting the 
Rational Windows License Server on page 71 for the Stop and Start buttons.

Entering Temporary Named-User License Keys

You may enter a temporary or evaluation license key on the license server if you are 
evaluating the product or AccountLink is unavailable.

Note:  You must have local administrative privileges for the server before you can 
enter the license key into the LKAD.

To enter license information in the LKAD:

1 Select License Keys > Enter a License in the menu bar of the License Key 
Administrator.

2 Select the type of license.

3 In the next dialog box, enter the following information:

❑ Product

❑ Expiration Date

❑ License Key

❑ Quantity (if you are installing a floating license key)

4 Click Finish. The License Key Administrator adds this information to the license 
key *.dat file in <Install Path>\Rational\common.

5 Edit the Options File (rational.opt). The LKAD provides an options file in which 
you can assign named-user license keys. As soon as you import the license key file, 
the Edit Options File dialog box appears. If you choose to edit the file:

a The options file automatically appears in a text editor. Follow the instructions 
in the file for the correct syntax in assigning user ids to license keys.

b After you edit the file, save it, and then close the file.

Note:  You can edit the options file while the license server is running, but stop and 
start the Rational license server after you have edited the file. See Starting the 
Rational Windows License Server on page 71 for the Stop and Start buttons.
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Starting the Rational Windows License Server

Start the Rational license server after you have imported or entered the license keys. 
The Rational license server will not start until license keys are installed. Use the 
correct procedure based on the Windows O/S version on your license server.

Note:  Although the control panel applet may still appear on your server from an 
earlier release of Rational server software, starting with version 2001, the Rational 
license server does not use the FLEXlm control panel applet. 

Starting the License Server on Windows XP

1 Click Start and select Settings  > Control Panel  > Administrative Tools  > Services  > 
FLEXlm License Manager.

2 Click Start the service.

Starting the License Server on Windows 2000

1 Click Start and select Settings  > Control Panel  > Administrative Tools  > Services  > 
FLEXlm License Manager.

2 In the General tab, click the Start button under Service Status.

Starting the License Server on Windows NT

1 Click Start and select Settings  > Control Panel  > Services. 

2 Select the FLEXlm License Manager in the Services dialog box and click the Start 
button.

Switching to Manual Startup

The Rational license server software is automatically set as a Windows NT service. 
The default Startup type is automatic, which means the license server starts 
automatically each time you start the computer. If you prefer to manually start the 
license server, switch the startup type.

Switching Startup Type on Windows XP

1 Click Start > Settings > Control Panel  > Administrative Tools  > Services > FLEXlm 
License Manager. 

2 Right-click FLEXlm License Manager, and then click Properties. 

3 On the General tab, in the Startup type scroll-down box, select Manual. 
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Switching Startup Type on Windows 2000

1 Click Start > Settings > Control Panel  > Administrative Tools  > Services > FLEXlm 
License Manager. 

2 In the General tab, select manual under Startup type.

Switching Startup Type on Windows NT

1 Click Start > Settings > Control Panel  > Services > FLEXlm License Manager. 

2 In the dialog box, select manual under Startup type.

Running the LKAD Command Line on Windows (Optional)

To automate license configuration on desktops, you can create a text file and batch file 
that specifies single, multiple, and redundant Rational license servers on users’ desktops. 
Users enter commands in Windows to run the batch file and text file.

Note:  These commands do not support node-locked license keys. 

■ If users are performing silent installations, add a post-installation section to the 
response.ini file. The post-installation section launches batch file commands after 
the installation finishes. The batch file directs the LKAD to use the server 
information in the text file. To add a post-installation command to the response.ini 
file, see Specifying the Post-Installation Command and Batch File on page 72. For more 
information about silent installations, see the Rational Server Products Installation 
Guide.

■ If users are not performing silent installations, you can have them use the 
command line to direct the LKAD to use information in the text file. To set up the 
text file and run the LKAD from the command line, see Creating the Text File That 
Specifies License Servers on page 73.

Specifying the Post-Installation Command and Batch File

After you record a response.ini file, append the following commands to the file.

1 Use a text editor such as Notepad to edit the response.ini file. Append a line similar 
to the following example to the end of the file. The label [PostInstallCmd] is 
required:
[PostInstallCmd]
Command=post-installation-commands.bat

2 Save the response.ini file to a unique name (to ensure that it is not overwritten by 
subsequent autocaptures). For example, save the response file with a name such as 
C:\responses\enterprise-windows-post.ini.
72 Rational Software License Management Guide



3 Use the same text editor to create the post-installation-commands.bat file. This batch 
file directs the LKAD to use the license server information in the text file 
(server-info.txt). This batch file might contain the following commands:
licadmin -fserver-info.txt
net send administrator “Installation Complete”

In this example, the desktop’s License Key Administrator, licadmin, starts and 
uses the information in server-info.txt to specify the name of the license server that 
the desktop will use. The batch file then sends a message to the administrator, 
indicating that the installation is complete.

4 See Creating the Text File for the LKAD commands to insert in the text file 
server-info.txt.

Creating the Text File That Specifies License Servers

The following section provides instructions for setting up the text file that specifies 
single, multiple, or redundant license servers. These instructions also provide the 
commands for running the LKAD from a command window if users are not running 
silent installations.

Specifying Single or Multiple License Servers

To specify the name of single or multiple Rational license servers in a desktop’s 
License Key Administrator:

1 Create a file in a text editor, such as Notepad, that contains the following line:
PortAtHost:27000@Server1
where Server1 is the name of the Rational license server. 

When you type this line:

❑ The keyword PortAtHost is case sensitive. 

❑ The number 27000 is the default port number.

❑ Use semicolons in the series of server names. The trailing semi-colon is also 
required.

To add an additional server, enter @Server2, where Server2 is the name of the 
additional Rational license server. 

PortAtHost:27000@Server1;@Server2;

2 Save the file, for example, server-info.txt.

3 In a command window (if the user is not running a silent installation), enter the 
following command:
licadmin -fserver-info.txt

Your computer will be configured to use floating license keys from Server1 and 
Server2.
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The results of running this command are written to the status file 
server-info.txt_STATUS, where server-info.txt is the name of the license parameter file you 
created. The status file is created in the directory where you placed the server-info.txt 
file. 

Specifying Redundant License Servers

To specify the names of redundant license servers in a desktop’s License Key 
Administrator:

1 Create a file in a text editor, such as Notepad, that contains the following line:
PortAtHost:27000@Redundant1,27000@Redundant2,27000@Redundant3;

where Redundant1 is the name of the primary Rational license server, Redundant2 is 
the name of the secondary license server, and Redundant3 is the name of the 
tertiary license server. The number 27000 is the default port number.

When you type this line:

❑ The license servers must be specified in the order of Primary, Secondary, and 
Tertiary (Backup) server. For more information about redundant server order, 
see Setting Up Redundant Windows License Servers (Optional) on page 77.

❑ The keyword PortAtHost is case sensitive.

❑ Use commas in the series of redundant server names. The trailing semi-colon is 
also required.

❑ You can specify redundant servers and multiple servers in one file. Use 
commas between redundant servers and semi-colons between servers.

PortAtHost:27000@Redundant1,27000@Redundant2,27000@Redundant3; 
27001@Server1;@Server2;

Or

PortAtHost:27001@Server1;27000@Redundant1,27000@Redundant2, 
27000@Redundant3;@Server2;

2 Save the file, for example, server-info.txt.

3 In a command window (if the user is not running a silent installation), enter the 
following command:
licadmin -fserver-info.txt

The results of running this command are written to the status file 
server-info.txt_STATUS, where server-info.txt is the name of the license parameter file you 
created. The status file is created in the directory where you placed the server-info.txt 
file.
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Specifying the License Server on Windows Web Servers

In the case of RequisiteWeb and ClearQuest Web, the Web server is the client of the 
license server. For example, when a user opens RequisiteWeb on a client, the 
RequisiteWeb Requirements server, on behalf of the user, requests the floating license 
from the Rational license server. 

Use the following procedures to specify the license server hostname(s):

1 Open the License Key Administrator (LKAD):

❑ After the product installation is complete, launch the LKAD Wizard and the 
LKAD. The License Key Administrator main window and the License Key 
Administrator Wizard dialog box appear

❑ If you decided not to launch the LKAD Wizard and LKAD immediately after 
product installation, click Start > Programs > Rational product name > Rational 
License Key Administrator. The License Key Administrator main window and 
the License Key Administrator Wizard dialog box appear.

2 Select Settings > Client/Server Configuration.

3 Click Add Server.

4 Single should be the default value next to Server Type. Enter the hostname of the 
license server in the Values column next to Server Name by clicking New-Server. 
After entering the hostname, press the Enter key.

Additional Servers

If you have additional license servers, click the Add Server button and enter the 
hostname for each server.

Note:  Do not use Add Server for a redundant server environment.

5 Click OK after you have entered all servers. 

Your Web server requests licenses from servers in the order that you enter the servers 
in the LKAD. If you want to change this order, see Changing the Server Search Order on 
page 32.

Configuring Web Servers to Use Redundant Windows Servers

Redundant servers are a system of three servers that work as a team to manage a 
single pool of floating license keys. If one of the servers goes down, the other two 
license servers automatically continue managing the license pool. 

To enter the redundant license servers on the Web server:

1 Click Settings > Client/Server Configuration.

2 Click Add Server.
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3 Click Single next to Server Type. A scroll-down menu should appear. Select 
Redundant in the menu.

4 Enter the Primary, Secondary, and Tertiary license server hostnames in the order in 
which the license administrator requested them in AccountLink. Press the tab key 
to move to the next line.

5 Click OK.

Difference Between Time-Out Period and Linger Time

The time-out period is the set period of product non-use after which the license server 
will reclaim a license. The Rational license server will reclaim a floating license when 
the product has not been used for a default period of 120 minutes. If you use the 
product again after the server has reclaimed its license, the product will check out the 
license again from the server.

The linger time is an interval that is reset to the beginning each time a user executes a 
command in the application. If the linger time expires before the user executes 
another command, the user's license is returned to the pool of available floating 
licenses, and the user has to acquire another license to execute any more commands. 
This linger interval is set and cannot be changed. 

Rational ClearCase LT and Floating License Linger Time

Unlike other Rational products, ClearCase LT licenses operate with a linger time of 30 
minutes. The first time a user executes a ClearCase LT command that takes a license, 
the license is allocated to that user for 30 minutes. This 30 minute “linger” interval is 
re-started every time the user executes a ClearCase LT command that takes a license. 
If ClearCase LT checks out a suite license, the suite license does not operate with a 30 
minute linger time. 

Modifying the Floating License Time-Out Period

To change the time-out period, create a text file called rational.opt in the <rational flexlm 
dir>\common directory. Enter one of the following two commands in the text file:

1 TIMEOUT feature seconds directs the license server to reclaim the feature 
(the product as it is listed in your license key file) after the number of seconds that 
you enter into the file.

2 TIMEOUTALL seconds directs the license server to reclaim all products after the 
number of seconds that you enter into the file.

The value for each of these options must be greater than 7200 seconds (or 120 
minutes). 
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Setting Up Redundant Windows License Servers (Optional)

Rational license servers can be set up to run in a fault-tolerant configuration known as 
redundant servers. Redundant servers are a system of three servers that work as a team 
to manage a single pool of floating license keys. If one of the servers goes down, the 
other two license servers automatically continue managing the license pool. If any 
two license servers no longer work, the third license server will no longer serve 
licenses. Two servers must operate to serve licenses to clients.

Example

You have purchased 25 floating licenses of Enterprise Suite and wish to set up a 
redundant server configuration on three Windows computers. You request permanent 
keys for the redundant servers using AccountLink. You install the Rational license 
server software on each of the three redundant server partners; servers A, B, and C. 
When you receive the license file of 25 permanent floating keys, you install the license 
file on each server. 

The three servers work as a team to manage all 25 floating licenses in unison. When 
you have 20 license keys checked out to your users and server A crashes, servers B 
and C continue to manage the 25 licenses.

Warning:  It is a common misperception that separating redundant servers across 
multiple sites (for example, one in US, one in Europe, one in Asia) provides 
maximum fault tolerance. This is not the case. Redundant servers should 
always be at the same site and on the same subnet.

To configure redundant license servers:

1 Install license server software on three computers. See Working with a Supported 
Network Configuration on page 64 and Installing the Rational License Server on a 
Windows Server on page 65.

Note:  Rational strongly recommends using a redundant environment of either all 
Windows servers or all UNIX servers.

2 Import a license file that you receive from Rational on each license server. See 
Using Floating Keys on a Windows License Server on page 68 for more information.

3 Start the license servers. The sequence is unimportant, but you should start the 
servers soon after one another. See Starting the Rational Windows License Server on 
page 71 for instructions.

4 Give desktop users the Primary, Secondary, and Tertiary (Backup) license server 
host names in the order in which you requested them in AccountLink. They need to 
enter the host names in their LKADs.
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License Monitoring (Optional)

You may need to monitor and report on license usage. GLOBEtrotter offers a solution 
for license usage reporting called SAMreport. SAMreport is designed specifically for 
reporting on license server activity. SAMreport offers a full set of administrative tools 
that generates reports, graphs, high-water marks, and even sets alarms to notify 
individuals when a server has gone down or the license pool is nearly exhausted. 
SAMreport works with any vendor's FLEXlm server. It is available only through 
GLOBEtrotter: http://www.globetrotter.com/samreport.htm.

If you do not need extensive license usage reporting, use the lmtools GUI to find 
out who used which license and when the user did so. If the license server is installed, 
click Start  > Programs  > Rational FLEXlm License Server  > License Tools. License 
Tools starts the lmtools GUI. 

1 Select Configuration using Services in the Mode menu.

2 Click the Server Status tab and the Perform Status Enquiry button in the Server 
Status dialog box.

Using Floating Licenses with a Firewall

Rational’s licensing implementation supports a firewall. To configure licensing with a 
firewall, give the lmgrd daemon (license manager) and the vendor daemon (Rational 
vendor or rational.exe) TCP/IP port numbers. The TCP/IP port is used for 
client/server communication for floating licenses.

In a non-firewall situation, the lmgrd daemon starts on TCP/IP port 27000 when you 
start the server. (You will have to change this number if another application is using 
this port number.) The lmgrd daemon assigns a random TCP/IP port number to the 
vendor daemon. 

In a firewall situation, the client cannot communicate with the daemons on the license 
server because the ports on which they are running are blocked. To enable license 
requests to pass through the firewall, assign numbers to the vendor and lmgrd ports. 
The vendor daemon and lmgrd daemon must start on a specific port number each 
time a client makes a license request and checks out a floating license from the server. 
The specified ports or connections remain open until the client returns the license to 
the server.

Note:  The vendor daemon and the lmgrd daemon cannot be set to the same port 
number.
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The following diagram displays a sample firewall situation. The Rational product on 
the right-hand side can communicate with the lmgrd daemon and rational.exe 
(vendor daemon) on the license server through the firewall because the numbers 
27000 and 8000 have been assigned to the ports.

When you specify the port information, the Rational License Key Administrator stores 
the port information in the registry.

The following procedures let you change the lmgrd and vendor ports in single, 
multiple server, or redundant server environments. They assume that you have 
already started the license server(s) and entered the host name(s) of the license 
server(s) in the License Key Administrator of each client.

Assigning Port Numbers in the Rational License Server

To enable clients to communicate with the license server, enter values in the lmgrd 
port and the Rational Vendor port.

To enter port numbers on a license server or redundant license servers:

1 Select Settings > Server Ports in the Rational License Key Administrator.

2 In the Server Ports dialog box, enter values in the lmgrd port and the Rational 
Vendor port, but do not set them to the same value.

3 Click OK.

4 If the server is a redundant server, enter the same port value on each of the 
redundant servers by repeating Steps 1–3. If there are multiple license servers, 
enter the same port value on each license server by repeating Steps 1-3.
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5 Give users the Rational Vendor Port value to enter into the License Key 
Administrators of their desktops. 

Changing the lmgrd Port 

When another application is using the TCP/IP port 27000 that is used by lmgrd 
(license manager daemon), change the lmgrd port. You do not need to enter a value 
in the Rational Vendor because it runs on a random TCP/IP port. 

The following procedures let you change the lmgrd port in single, multiple, or 
redundant server environments. They assume that you have already started the 
license server(s) and entered the hostname(s) of the license server(s) in the License 
Key Administrator of each desktop.

To change the lmgrd port value on a license server or redundant server:

1 Select Settings > Server Ports in the Rational License Key Administrator.

2 In the Server Ports dialog box, enter a value in the lmgrd port.

3 Click OK.

4 If the server is a redundant server, enter the same lmgrd port value on each of the 
other license servers by repeating Steps 1–3.

Removing the Rational Windows License Server Software

This section describes how to remove the license server software from the server.

Before You Remove the License Server Software

1 Make sure that no one is using the license server or any associated files. You 
cannot remove files that are in use.

2 Return the license keys to your Rational Account through AccountLink 
(www.rational.com/accountlink). For more information about moving or returning 
licenses, see Returning or Moving Keys for Administrators on page 101.

3 To remove the software from a Windows computer, you must have Windows 
administrator privileges on the local computer.

Removing the License Server Software

Use the Windows Add/Remove Programs control panel to select and remove the 
license server software. The Rational installation program removes the files from your 
computer. It does not remove directories that contain files that you created while you 
were using the software. It also does not remove the license key files from the server.
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9Configuring a Rational 
UNIX License Server
Floating and named-user floating keys let you manage and maintain licenses on 
single, multiple, or redundant Rational UNIX license servers.

This chapter describes how to set up and run Rational UNIX license servers. The 
information in this chapter is intended for system administrators or users who 
manage licenses. If you want to use a Windows license server, see Configuring a 
Rational Windows License Server on page 61.

Some of the tasks in this chapter are not recommended for the casual or novice user. 
Attempt them only if you have experience with the UNIX operating system and 
Rational Common Licensing. You can apply the UNIX commands to all UNIX 
operating systems unless the text indicates the command is for a specific UNIX 
operating system.

Windows Clients Using a UNIX License Server

If you have purchased DevelopmentStudio for UNIX, see the Rational Suite Installation 
Guide (UNIX) or a Rational UNIX point-product installation manual for information 
about configuring a Rational UNIX license server. You can also find UNIX installation 
manuals at www.rational.com. 

1 Select Support > Documentation. 

2 Register for a logon id if you have not already done so. 

3 Select the installation guide for the UNIX version of your product.

If you do not have access to a Rational UNIX installation manual, use the procedures 
in this chapter to set up a UNIX license server. This chapter does not provide 
instructions for configuring UNIX clients to access the UNIX Rational license server.
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Setting Up Floating and Named-User Keys on a UNIX Server

The general steps required to set up floating or named-user floating licenses on a 
UNIX license server are described in Table 14. The table provides a checklist of tasks 
as well as references to more detailed instructions.

Table 14 Guide to Setting Up Floating Licenses on a UNIX Server

To Procedures

Set up floating licenses 1 Understand the Rational Common Licensing model. 
See Before Requesting License Keys on page 41.

2 Access AccountLink 
(http://www.rational.com/accountlink) to order 
permanent license keys for the products on your 
Windows clients. See Requesting License Keys on 
page 55 for more information about AccountLink.

3 Make sure your license server and clients are 
connected. See Before You Install the Rational License 
Server on page 84.

4 Install the Rational license server software and license 
keys on the UNIX license server. See Installing the 
Server Software and Floating License Keys on page 85.

5 Tell client users to specify the Rational license server in 
their Windows desktops. See Configuring Desktops to 
Use Floating License Keys on page 29.
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Set up named-user floating 
licenses (only applies to Rational 
Purify, Quantify, and 
PureCoverage)

1 Understand the Rational Common Licensing model. 
See Before Requesting License Keys on page 41.

2 Access AccountLink 
(http://www.rational.com/accountlink) to order 
permanent license keys for the products on your 
Windows clients. See Requesting License Keys on 
page 55 for more information about AccountLink.

3 Make sure your license server and clients are 
connected. See Before You Install the Rational License 
Server on page 84. 

4 Install the Rational license server software and license 
keys on the UNIX server. See Installing the Server 
Software and Named-User Keys on a UNIX Server on 
page 87.

5 The License_Setup script asks you for user ids to 
assign to the license keys. 

6 Tell client users to specify the Rational license servers 
in their Windows desktops. See Configuring Desktops to 
Use Floating License Keys on page 29.

Configure redundant license 
servers

See Setting Up Redundant UNIX Servers (Optional) on 
page 88.

Change the order in which 
Rational products use licenses.

The license server does not set license usage order. Use 
the desktop to change the order. See Changing License 
Usage Order on page 35

Using license keys for home use or 
travel

Disconnected use from UNIX license servers is not 
supported. See Using Floating License Keys for Home Use or 
Travel on page 52 for other options.

Modify the time-out period See Modifying the Floating License Time-Out Period on 
page 97.

Monitoring Rational license server 
activity

See License Monitoring (Optional) on page 98.

Upgrading the license server 
software.

You can upgrade the Rational license server software to 
the most current version, but do not run different 
versions of Rational license server software on the same 
computer.

Table 14 Guide to Setting Up Floating Licenses on a UNIX Server (continued)

To Procedures
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Installing the License Server and License File on a UNIX Server

Installing the license server software on a UNIX computer also involves installing or 
entering the license keys. You should have your license key file or Rational License 
Key Certificate ready when you install the Rational license server. Go to AccountLink 
(http://www.rational.com/accountlink) to order your permanent license keys or find the 
temporary key code on your License Key Certificate.

Before You Install the Rational License Server

To set up the Rational license server on a UNIX computer, you need the Rational 
license_setup script and licensing executables from Rational’s ftp site. 

The requirements are minimal:

■ The Rational license server can be installed on all the UNIX platforms that Rational 
supports. Rational does not support SunOs 4.x and IRIX 5.x.

■ The default TCP/IP port number is 27000 to 27009. Use port number 1501 through 
26999 for redundant servers.

■ There is no minimum recommended processor, memory, or disk space. 

■ The license server software must be installed locally (NFS is not supported). The 
server runs a FLEXlm lmgrd process and a rational daemon process to manage 
licenses. For more information about these processes, see Understanding Rational 
Licensing Components on page 103.

■ To check the connection between the server and clients, use the following UNIX 
commands: ping, arp, rsh, rlogin, or telnet.

Running multiple license servers 
on the same computer

Rational and GLOBEtrotter recommend running a 
separate lmgrd instance for each vendor daemon and 
keeping license keys in separate files.

Most vendors have an expected location for the license 
file. If your company has license files from multiple 
vendors, you can keep the data in separate files and set 
the LM_LICENSE_FILE environment variable to 
reference these multiple files.

Remove the license server 
software

See Removing the Rational UNIX License Server Software on 
page 98.

Table 14 Guide to Setting Up Floating Licenses on a UNIX Server (continued)

To Procedures
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■ AccountLink sends the license file to an e-mail account when you request a license. 
It has the filename format similar to license_for_server.upd. You need to have either 
the license file (filename.upd) stored in a known location, such as the $HOME 
directory, on the license server or you need a printout of the contents of the license 
file available during the license server installation. 

Installing the Server Software and Floating License Keys

Perform the following steps to install the license server and floating license key file on 
a UNIX computer.

1 Download the Rational license_setup script and licensing executables from the ftp 
site at: ftp://ftp.rational.com/public/tools/flexlm. Everything you need is in 
License_Setup.<OS>.tar.z (For Linux, it is License_Setup.Linux.tar.gz).

Occasionally, downloading the file causes the periods in the filename to be 
replaced with underscores. If this happens, rename the file by replacing the 
underscores with periods.

2 Copy the Rational files to the $FLEXROOT directory on the server. The term 
$FLEXROOT is used herein to represent the location from which you plan to run 
license_setup.

The license_setup command allows you to set up license options and run the 
license check sequence.

3 Unpack the files as shown in the example below.

Example using the HP-UX tar file:

cd $FLEXROOT

uncompress -c License_Setup.HP-UX.tar.Z | tar -xf -

The directory License_Setup.HP-UX is created at FLEXROOT after you uncompress 
the tar file.

Warning: Be sure to copy the appropriate tar file for the platform on which you are 
installing.

4 Run the License_Setup script in the directory created by the uncompress/tar 
command. The directory will not have the suffix: .tar.*

cd License_Setup.HP-UX

./license_setup

The script starts by providing instructions for using license_setup.

The script prompts you for a Rational directory, such as rational_dir/config directory.

5 Choose to accept or not accept the Rational Software license agreement. 

❑ If you accept the license agreement, the script continues. 
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❑ If you do not accept the license agreement, you cannot continue with the script. 
Exit the program. The script exits and makes no changes to the server.

6 Choose your license option from the Licensing Options Menu. Options are 
summarized in the following table.

7 Enter the temporary license key information:

❑ License key

❑ License type

❑ Expiration date

When you have finished, go to Step 10.

8 Provide your license file information by doing one of the following: 

❑ Import the information from the license file automatically by giving the path to 
the.upd file. 

❑ Enter none to provide the license key information manually. You will need a 
printout of the content of the .upd file. Follow the prompts to enter the 
information.

Note:  Rational recommends importing the information over entering the 
information manually because the data is case-sensitive and very literal.

Option Description

1 Choose this option if you have a permanent license key or a Term 
License Agreement (TLA). This option upgrades the license 
server software (FLEXlm 7.0f).

Note: license_setup prompts you to provide the location of the 
license file or gives you the option to enter the license key 
information manually. If you do not have a license file containing 
your license keys, see Requesting License Keys on page 51.

If you are using a permanent license, go to Step 8.

2 Choose this option if you do not have a permanent license yet and 
you want to install the product immediately, or if you want to 
install the product for evaluation purposes.

Note: You need to have your temporary licensing information 
(from a sales representative or from Rational.com) available as 
license_setup prompts you for a license key.

If you are using a temporary license, go to Step 7.
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9 Define the location for the <server-name>.dat file that will be created from the 
information supplied by the license_for_server.upd file. By default, license_setup 
creates the <server-name>.dat file and stores it in the rational_dir/config directory.

Choose either the default path (option 1, rational_dir/config directory) that 
license_setup has selected or choose option 2 to specify an alternate path.

10 Proceed with the License Check Menu. 

Run through options 1–3 sequentially and forward to the next menu. If you are 
setting up a permanent node-locked license, run through option 1 only. Note that 
these options are the default settings provided by license_setup.

Restarting the UNIX License Server When It Reboots

After the license file is in place and the license daemons are running, the license server 
needs to be set up to automatically restart when it reboots. The license_setup script 
cannot do this automatically for you unless you ran the script as root (root 
permissions). If you are not running the script as root, the script directs you to become 
root and copy a file. The script directs you to the correct location based on the 
operating system that you are using for placing the start-up files.

The following sections provide the start script commands for the Solaris and HP-UX 
operating system.

Sun Solaris
$ su

# cp rational_dir/config/start_lmgrd_on_server-name \

/etc/rc2.d/S98Rational

HP-UX

% su

# cp rational_dir/config/start_lmgrd_on_server-name \

/sbin/init.d/S98Rational

# ln -s /sbin/init.d/S98Rational/sbin/rc2.d/S98Rational

Installing the Server Software and Named-User Keys on a UNIX Server

Named-user license keys behave like floating license keys except the license_setup 
script offers you the opportunity to specify a user for each license key. You assign a 
user to a key by creating a rational.opt file. The options file locks the floating license key 
to the user; allowing the user to run Rational Purify, Quantify, or PureCoverage on 
multiple systems. 
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Follow the procedures explained in Installing the Server Software and Floating License 
Keys on page 85. The only difference that you will see is the script will prompt you for 
user names and create the rational.opt file for you.

Setting Up Redundant UNIX Servers (Optional)

Redundant servers are a system of three servers that work as a team to manage a 
single pool of floating license keys. If one of the servers goes down, the other two 
license servers automatically continue managing the license pool. This type of 
redundant configuration requires that a minimum of two license servers running at 
all times. If two servers go down, licenses will be unavailable until one of the servers 
is restarted.

Example

You have purchased 25 floating licenses of Enterprise Suite and wish to set up a 
redundant server configuration on three UNIX computers. You request permanent 
keys for the redundant servers using AccountLink. You install the Rational license 
server software on each of the three redundant server partners; servers A, B, and C. 
When you receive the license file of 25 permanent floating keys, you install the license 
file on each server. 

The three servers work as a team to manage all 25 floating licenses in unison. When 
you have 20 license keys checked out to your users and server A crashes, servers B 
and C continue to manage the 25 licenses.

Warning:  It is a common misperception that separating redundant servers across 
multiple sites (for example, one in US, one in Europe, one in Asia) provides 
maximum fault tolerance. This is not the case. Redundant servers should 
always be at the same site and on the same subnet.
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A homogeneous redundant server setup is recommended (that is, all servers are 
running the same operating system); however, heterogeneous environments are 
supported. For example, you could have two license servers running Solaris and one 
running HP-UX. See the following illustration.

Note:  Rational strongly recommends using a redundant environment of either all 
Windows servers or all UNIX servers.

Before You Install the License Server on Redundant UNIX Servers

To set up the license server software on redundant UNIX servers, you need the 
Rational licensing executables from Rational’s ftp site and a license key file for 
redundant UNIX servers from AccountLink. Then configure a start script and start 
each server. 

The license_setup script cannot import license key files for redundant servers, and it 
cannot start redundant servers.

Here are the requirements for setting up redundant servers:

■ If you have already set up a license server and want to use that server in the 
redundant server configuration, remove the Rational license server software from 
the server. See Removing the Rational UNIX License Server Software on page 98 for 
more information. 

a Return the license keys to AccountLink (Moving or Removing License Keys on a 
UNIX Server on page 96). 

b Follow the instructions in this section for installing the Rational license server 
and license keys in a redundant server configuration.

■ Request the license key file for redundant UNIX servers. Go to AccountLink 
(http://www.rational.com/accountlink) and request a license for redundant servers. 
AccountLink will ask you for the primary, secondary and backup servers. Be sure 
to specify the redundant servers in the correct order:

❑ Host ID is the primary server
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❑ Host Name #2 is the secondary server

❑ Host Name #3 is the backup server

If you have problems receiving or working with the redundant server license file, 
see Contacting Rational Licensing Customer Support on page xvi. Technical support 
will create a new license file for you.

Note:  If you do not have an internet connection, see Requesting License Keys 
(Without an Internet Connection) on page 58.

■ The Rational license server can be installed on all the UNIX platforms that Rational 
supports. Rational does not support SunOs 4.x and IRIX 5.x. 

■ There is no minimum recommended processor, memory, or disk space. 

■ AccountLink sends the license file to an e-mail account when you request a license. 
It has the filename format similar to license_for_server.upd. 

■ The default TCP/IP port number is 27000 to 27009. Specify port number 1501 
through 26999 for redundant UNIX servers.

■ To check the connection between the servers and clients, use the following UNIX 
commands: ping, arp, rsh, rlogin, or telnet.

■ The servers should be on the same subnet. 

■ The license server software must be installed locally (NFS is not supported). Each 
server runs a FLEXlm lmgrd process and a rational daemon process to manage 
licenses. For more information about these processes, see Understanding Rational 
Licensing Components on page 103.

■ You must manually install the FLEXlm license server software on the servers.

Installing the Server Software and Keys on Redundant UNIX Servers

Because license_setup script cannot import a redundant license key file, install the 
Rational license server software and license key file manually on each of the three 
servers.

1 Place a copy of the license file that you receive from AccountLink on each of the 
three license servers and ensure that the order of the SERVER lines is the same in 
each file. 

a You can verify the order of the SERVER lines by opening the license file and 
checking for three server lines. 

➑ If you do not have a three-server license file, return your license file to 
AccountLink (Return transaction) and request a new license file for 
redundant UNIX servers. If you have problems receiving, returning, or 
working with the redundant server license file, see Contacting Rational 
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Licensing Customer Support on page xvi. Technical support will make the 
correct changes to your account and create a new license key file for you.

➑ If the SERVER lines are not in the correct order, you can edit the file to 
change the order, change the server name (not the host id), and change the 
port number. You cannot add or delete server lines.

b The license file (license_for_primary.upd) needs to be copied to the $FLEXROOT 
directory. You need to maintain this file on all three servers. Copy and rename 
the file to rational.dat as shown below:

cp license_for_primary.upd $FLEXROOT/rational.dat

c Assign a TCP/IP port to each server. You must assign a TCP/IP port number to 
each server by modifying the port assignment in each SERVER line.

Warning:  Redundant servers cannot communicate with each other if you use 
the default port numbers: 27000 to 27009. Use a port number between 1501 and 
26999. Ensure that the port number you use is not in conflict with any other 
TCP/IP services.

i Choose three port numbers between 1501 and 26999 to use for each server. 
Note that the same port number can be used for each server, or the port 
numbers can be unique.

ii Check that the port is not already in use. (Port 1706 is used in the sample 
commands below.)

.Check the etc/services file

grep "[ ]1706/" /etc/services

.Check the NIS services by using the ypcat services command.

ypcat services | grep "[ ]1706/"

Note:  There is a tab and a space character between the [ ].

iii Edit the license file to use the new port numbers.

cd $FLEXROOT

vi rational.dat

Your license file should look similar to the example below.

SERVER primary 8001d410 1706

SERVER secondary 8001d625 1706

SERVER backup 8001d873 1706

2 Download the Rational licensing executables from the ftp site at: 
ftp://ftp.rational.com/public/tools/flexlm. Do not download License_Setup.<OS>.tar.z. 
Download flexlm.7.0f.<os>.tar.z
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Occasionally, downloading the file causes the periods in the filename to be 
replaced with underscores. If this happens, rename the file by replacing the 
underscores with periods.

3 Copy the FLEXlm files to the $FLEXROOT directory on all three servers. The term 
$FLEXROOT is used herein to represent the location from which you plan to run 
FLEXlm.

4 Unpack the files as shown in the example below.

Example using the HP-UX tar file:

cd $FLEXROOT

uncompress -c flexlm.7.0f.hp.tar.Z | tar -xvf -

The directory flexlm.7.0f/hppa_hpux is created at FLEXROOT after you uncompress 
the tar file.

Note:  Be sure to copy the appropriate tar file for the platform on which you are 
installing.

Configuring and Starting the Redundant UNIX License Servers
You must do the following to start the redundant servers:

■ Configure the start script for each server. This is best done by copying a template 
file from the Rational FTP site and modifying it. The FTP address is provided in 
the following section.

■ Start each license server manually by using the start_lmgrd script.

Configuring the Start Script
Working from the $FLEXROOT directory, create a start script for each server. 

1 Obtain a template start script at the Rational FTP site: 
ftp://ftp.rational.com/public/tools/flexlm/start_lmgrd

2 Copy the template file to the $FLEXROOT directory on all three license servers.

3 Set the following four variables in the start_lmgrd script.

Solaris Example:

FLEXROOT=/usr/rational/flexlm.7.0f

LICENSE_DIR=$FLEXROOT/sun4_solaris2

LICENSE_DAT=$FLEXROOT/rational.dat

LICENSE_USER=joe
92 Rational Software License Management Guide



HP-UX Example:

FLEXROOT=/usr/rational/flexlm.7.0f

LICENSE_DIR=$FLEXROOT/hppa_hpux

LICENSE_DAT=$FLEXROOT/rational.dat

LICENSE_USER=joe

The above examples show the license server being installed in the same location, 
using the same license file name, and the same user. This helps simplify the setup 
and makes it easier to maintain.

Starting Redundant UNIX License Servers
The servers must be started in the correct order: primary, secondary and backup.

1 At the FLEXROOT directory (/usr/rational/flexlm.7.0f) where you copied the template 
start script (start_lmgrd), enter the following command:

./start_lmgrd

2 Repeat Step 1 for the secondary and backup servers.

3 Check the status of each server:

./start_lmgrd lmstat -a

You should see the three servers listed as running and a list of the license keys 
being served.

To stop the license servers:
Stop each license server by entering the following command:
./start_lmgrd stop

To verify the license file:
Check the Rational INCREMENT lines by running the exinstal command:
./start_lmgrd ex

This command will generate a report on all the increment lines and identify if they are 
properly encrypted.

Problems Starting the Redundant UNIX License Servers

If the license server will not start, check the corresponding lmgrd log file (specified by 
LICENSE_LOG in start_lmgrd).

1 Error message: ulimit: bad ulimit

If you see this message when you run start_lmgrd, remove the ulimit command 
from the script.
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2 If there are any other problems, check that the start scripts reference the correct 
license file (LICENSE_DAT), the license directory (LICENSE_DIR), and the license 
log file (LICENSE_LOG). Mail the start scripts, the license files, and the log files to 
support@rational.com. For more information about contacting Rational Licensing 
Support see Contacting Rational Licensing Customer Support on page xvi.

Restarting the Redundant UNIX Servers When They Reboot

All three license servers should be set up to be restarted at boot time. To set this up, 
copy the start script to the appropriate system directory.

Note:  For security reasons, we recommend that you do not run lmgrd as root. Run 
lmgrd as a user by setting the LICENSE_USER variable. The user id that you specify, 
must exist on the system that runs the start script. In the example below, the user is set 
to “joe”.

FLEXROOT=/usr/rational/flexlm.7.0f

LICENSE_DIR=$FLEXROOT/hppa_hpux

LICENSE_DAT=$FLEXROOT/rational.dat

LICENSE_USER=joe

In previous releases, Rational used the filename SlmRational.sh in the system start 
directories. If there is an SlmRational.sh file under any of the /etc/ or /sbin directories 
they should be removed and replaced with S98Rational. The following sections 
provide the start script commands for each operating system.

Note:  You must be root to perform these steps.

Sun Solaris
cd /usr/rational/flexlm

cp start_lmgrd /etc/rc2.d/S98Rational

If you need to remove a reference to the SlmRational.sh file, use the following 
command to do so:
/bin/rm -f /etc/rc2.d/SlmRational.sh

HP-UX
cd /usr/rational/flexlm

cp start_lmgrd /sbin/init.d/S98Rational

ln -s /sbin/init.d/S98Rational /sbin/rc2.d/S98Rational

If you need to remove a reference to the SlmRational.sh file, use the following 
command to do so:
/bin/rm -f /sbin/*.d/SlmRational.sh
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SGI IRIX
cd /usr/rational/flexlm

cp start_lmgrd /etc/init.d/S98Rational

ln -s /etc/init.d/S98Rational /etc/rc2.d/S98Rational

If you need to remove a reference to the SlmRational.sh file, use the following 
command to do so:
/bin/rm -f /etc/*.d/SlmRational.sh

IBM AIX
Edit /etc/inittab and add a line to run the start script using /bin/sh:

lmgr:234:once:/bin/sh/usr/rational/flexlm/start_lmgrd

Linux
cd /usr/rational/flexlm

cp start_lmgrd /etc/rc.d/init.d/S98Rational 

ln -s /etc/rc.d/init.d/S98Rational /etc/rc.d/rc3.d/S98Rational 

ln -s /etc/rc.d/init.d/S98Rational /etc/rc.d/rc4.d/S98Rational 

ln -s /etc/rc.d/init.d/S98Rational /etc/rc.d/rc5.d/S98Rational 

License Manager Commands

Rational Common Licensing uses the License Manager, version 7.0f, from Globetrotter 
Software, Inc. The License Manager includes the following components:

■ A vendor daemon named rational that dispenses Rational Software licenses. The 
rational daemon is used for all of Rational’s licensed products. If you have other 
products from other vendors that also use FLEXlm, they will include their own 
vendor daemons.

■ A license daemon named lmgrd. The lmgrd daemon does not process requests on its 
own, but forwards requests to the appropriate vendor daemon.

■ A license file that you maintain. The license file specifies your license servers, 
vendor daemons, and product licenses.

Note:  Rational recommends that you use a single combined license file for all of your 
Rational products.

To verify that your license manager is operational, you can enter these commands on 
your UNIX license server to see if its daemons are running:
% ps axw | grep -v grep | egrep “lmgrd|rational”
or
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% ps -e | grep -v grep | egrep “lmgrd|rational”

The output should include lines similar to the following (your path names may vary):
538 ?? S 0:03.50 /rational/base/cots/flexlm.7.0f/platform/lmgrd
-c /rational/config/servername.dat
-l /rational/config/servername.log
539 ?? I 0:00.90 rational -T brazil 6.0 3 -c ...

The following table summarizes the system-administration commands that the 
license manager provides.

Additional Licensing Commands

In addition to using the commands in the above table, you can also use the 
license_check command to run the FLEXlm lmstat command for counted licenses and 
the exinstal command for any license file (not port@host). The lmstat command queries 
the license server for a list of licenses that are in the license pool. The exinstal 
command checks the license file format and license codes to see if everything is 
consistent.

Moving or Removing License Keys on a UNIX Server

Use AccountLink to return or remove node-locked, floating, named-user floating, and 
redundant license keys to your Rational account. When you return a license key, you 
do not physically give the license key back to Rational. Instead, use the Return 

Command Description

lmdiag Allows you to diagnose problems when you cannot 
checkout a license

lmdown Shuts down license and vendor daemons 

lmhostid Reports license manager host ID of workstation 

lmremove Returns specific licenses to license pool on license server 
(for example, after a system crashes)

lmreread Rereads license file, starts new vendor daemons 

lmstat Reports status on daemons and feature usage 

exinstal Reports on licenses in license file that you specify on the 
command line
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transaction in AccountLink. The AccountLink transaction updates Rational’s records 
to indicate that you are no longer using a Rational product on that computer. This 
adjusts the count of registered products in your account. 

Note:  If you have problems returning, or requesting a new redundant server license 
file, see Contacting Rational Licensing Customer Support on page xvi. Technical support 
will make the correct changes to your account and create a new license file for you.

Use the return transaction in AccountLink to update the count of registered products 
in your Rational account before you order new license keys.

To return a license key: 

1 Perform the return transaction in AccountLink.

2 Remove the Rational license server software from the old server. To remove the 
Rational license server from a UNIX server, see Removing the Rational UNIX License 
Server Software on page 98.

If you want to move Rational software to another server, return the existing license 
keys from the old server to your Rational account. Then order license keys for the new 
server.

To move license keys from one server to another:

1 Use AccountLink to return the license keys to your Rational account.

2 Request new license keys for the new server in AccountLink.

3 Remove the Rational license server software from the old server. To remove the 
Rational license server from a UNIX server, see Removing the Rational UNIX License 
Server Software on page 98.

4 Install the Rational license server software on the new server. 

5 Import the new license key file on the new server. 

6 Give users the name of the new license server. 

Modifying the Floating License Time-Out Period

The time-out period is set to a default of 120 minutes. This means the Rational license 
server will reclaim a floating license when the product has not been used for 120 
minutes. If you use the product again after the server has reclaimed its license, the 
product will check out the license again from the server. If you want the product to 
hold the license key for a longer period of time, you can change the time-out period.

To change the time-out period, create a text file called rational.opt in the <rational flexlm 
dir>\common directory. Enter one of the following two commands in the text file:
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1 TIMEOUT feature seconds directs the license server to reclaim the feature 
(the product as it is listed in your license key file) after the number of seconds that 
you enter into the file.

2 TIMEOUTALL seconds directs the license server to reclaim all products after the 
number of seconds that you enter into the file.

Note:  The value for each of these options must be greater than 7200 seconds (or 120 
minutes). 

License Monitoring (Optional)

You may need to monitor and report on license usage. GLOBEtrotter offers a solution 
for license usage reporting called SAMreport. SAMreport is designed specifically for 
reporting on license server activity. SAMreport offers a full set of administrative tools 
that generates reports, graphs, high-water marks, and even sets alarms to notify 
individuals when a server has gone down or the license pool is nearly exhausted. 
SAMreport works with any vendor's FLEXlm server. It is available only through 
GLOBEtrotter. Detailed information on SAMreport can be found at: 
http://www.globetrotter.com/samreport.htm.

Removing the Rational UNIX License Server Software

This section describes how to remove the license server software from the computer.

Before You Remove the License Server Software

Return the license keys to your Rational Account through AccountLink 
(www.rational.com/accountlink), the online license management tool. For more 
information about moving or returning licenses, see Moving or Removing License Keys 
on a UNIX Server on page 96.

Removing the License Server Software

To remove the Rational license server from the UNIX server.

1 Go to $FLEXROOT or /usr/rational/flexlm.7.0f

2 Shut down the server with one of the following commands:

lmdown -c <license_file> 
Example: lmdown -c rational.dat

or 

lmdown -c <port@host>
Example: lmdown -c 27000@hershey
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or 

ps -e | grep lmgrd # 
To find the pid of lmgrd

kill <pid> # 
Where <pid> is the process id of lmgrd 

Note:  If you use kill -9 <pid>#, the server might leave a lockrational file in either /tmp 
or /usr/tmp. You will need to remove this file.

3 To remove the license server software, go to the <rational_dir> directory at 
$FLEXROOT and delete the Rational FLEXlm directory installed under base/cots: 

cd <rational-dir> or /usr/rational/flexlm.7.0

rm -fr base/cots/flexlm.7.0f 

or 

To remove just the Solaris software:

rm -fr base/cots/flexlm.7.0f/sun4_solaris2 

To remove just the HP-UX software:

rm -fr base/cots/flexlm.7.0f/hppa_hpux
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10Returning or Moving Keys 
for Administrators
If you have to upgrade your license keys, replace an old license server, or move the 
license keys to another computer, you must perform a floating or node-locked license 
key return transaction in AccountLink. Because permanent node-locked and floating 
license keys are tied to a computer’s host ID, Rational products will not work on 
another computer until you register the products to the new computer. 

Returning or Removing Permanent License Keys

Use AccountLink to return node-locked, floating, named-user floating, and 
redundant server license keys to your Rational account. When you return a license 
key, you do not physically give the license key back to Rational. Instead, you use the 
Return transaction in AccountLink. The AccountLink transaction updates Rational’s 
records to indicate that you are no longer using a Rational product on that computer. 
This adjusts the count of registered products in your account. 

After AccountLink makes the adjustments to your account, Rational sends you a 
license key file that contains updated license keys. If you have returned all the license 
keys for a computer, the updated license file is empty. To comply with your License 
Agreement, import this updated license file (whether it is empty or not) on the 
computer.

Use the return transaction in AccountLink to update the count of registered products 
in your Rational account before you request new license keys.

Note:  If you have problems returning or requesting a new redundant server license 
file, see Contacting Rational Licensing Customer Support on page xvi. Technical support 
will make the correct changes to your account and create a new license file for you.

To return a license key: 

1 Perform the return transaction in AccountLink.

2 When you receive the update file from AccountLink, import the file on the old 
desktop or license server. For more information, see Installing Permanent or Term 
License Agreement (TLA) Keys on page 26.

3 Remove the Rational software or license server software from the old desktop or 
license server. See the Rational Server Products Installation Guide for the removal 
procedures.
101



Moving Permanent License Keys

If you want to move Rational software to another desktop or server, return the existing 
license keys from the old desktop or server to your Rational account. Then request 
license keys for the new desktop or server.

Note:  If you have problems returning or requesting a new redundant server license 
file, see Contacting Rational Licensing Customer Support on page xvi. Technical support 
will make the correct changes to your account and create a new license file for you.

To move license keys from one computer to another:

1 Use AccountLink to return the license keys to your Rational account. See Returning 
or Removing Permanent License Keys on page 101.

Note:  To help prevent you from confusing the license key update file for the old 
computer with the license key file for the new computer, you may want to 
complete the return transaction before you order license keys for the new 
computer.

2 Request new license keys for the new computer in AccountLink.

3 Remove the Rational software or license server software from the old computer. 
See the Rational Server Products Installation Guide for the removal procedures.

4 Install the Rational software or license server software on the new computer. 

5 Import the new license key file on the new computer. 

6 If you moved the license keys to a new license server, give desktop users the host 
name of the new license server. 
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11Understanding Rational 
Licensing Components
This chapter describes how Rational Software has implemented FLEXlm features and 
options in Rational Common Licensing. 

Locating the Licensing Components

All Rational software files and Rational license key files are installed in <Install 
Path>\Rational\Common\ unless otherwise noted. 

Understanding the Rational License Server Process

Licenses are managed by a license manager that runs on a license server. The license 
manager monitors license access, simultaneous usage, idle time, and so on. When you 
start any Rational product, you are initially unlicensed. If a license for that product is 
available, the license manager gives you a license. You retain the license as long as you 
keep using the product. When you exit the Rational application, your license is 
returned to the license manager and is made available for another user. If a license is 
unavailable, you are unable to use the product until a license is returned by another 
user.

The following sections provide detailed information about the Rational license server 
and license file, including descriptions of the license daemons running on the server.

License Components

The Rational license configuration includes these major components, which are 
described in the following sections: 

■ License key file 

■ License manager daemon (lmgrd)

■ Vendor daemon 
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License Key File

License key definitions are stored in a text file called the license key file. Rational creates 
the license key file based on the data that you provided in AccountLink. The license 
file can contain license key data for several Rational products and is created for a 
specific host. The Rational License Key Administrator that is installed with every 
Rational product edits and installs the license key file.

The license key definition contains information about the server nodes and vendor 
daemons, and at least one line of data (called FEATURE or INCREMENT lines) for 
each licensed product. Each FEATURE line contains a license key based on the data in 
that line, the host IDs specified in the SERVER lines, and other vendor-specific data. 

When users start a Rational product, the environment variable LM_LICENSE_FILE is 
automatically defined for them. License manager uses this variable to locate the 
license file.

License File Names

Table 16 describes the types of Rational license key files.
 

Table 16 License Key Files

File Name Description Notes

rational_temp.dat Contains all node-locked 
temporary license keys. 

You must obtain a permanent 
license key to continue to use your 
Rational Software product past the 
temporary key expiration date.

rational_perm.dat Contains all node-locked 
permanent license keys.

Go to Rational AccountLink to 
request permanent keys.

rational_server_temp.dat Contains all temporary 
floating license keys on a 
license server.

You must obtain a permanent 
license key to continue to use your 
Rational Software product.

rational_server_perm.dat Contains all permanent 
floating license keys on a 
license server.

Go to Rational AccountLink to 
request new permanent license keys.
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The Floating License Server Line

This section explains the line used to set up a license server in the license key file.

A typical Rational SERVER line is similar to the following example:

SERVER   curley   DISK_SERIAL_NUM=12345678

Entering the License Server Name on the Client

When you enter the name of the license server in the License Key Administrator 
(LKAD) of the client, the LKAD writes the hostname of the license server to an empty 
license file in the <rational>\common directory on the client.

License Manager Daemon (lmgrd)

Rational uses two daemons (or processes) to manage floating licenses:

■ lmgrd, the license manager daemon

■ vendor daemon

The lmgrd daemon and the vendor daemon work together to manage the license keys. 
The lmgrd handles the initial contact with the client application programs, passing the 
connection on to the appropriate vendor daemon. It also starts and restarts vendor 
daemons. 

By default, the lmgrd on Windows is a Windows NT service.

The lmgrd daemon starts on TCP/IP port 27000 (default) when you start the server. 
The lmgrd daemon will assign a random vendor TCP/IP port number (unless you set 
up a firewall) to the vendor daemon and start the vendor daemon on that port.

Item in SERVER Line Description

SERVER Tells the server that the license file will be used for floating or 
counted node-locked licenses. This is needed in a floating license 
file along with a VENDOR or DAEMON line.

curley The hostname of the license server. 

Allows the license server’s hostname or IP address to populate the 
hostname field in the SERVER line. Rational also allows both 
values. The hostname value is not encrypted into floating license 
keys.

12345678 The host ID of the license server.

The default value is the disk serial number (DISK_SERIAL_NUM) 
of the user’s boot drive. The HOST ID value is encrypted into 
floating license keys.
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Vendor Daemon

The vendor daemon is a program developed by Rational implementing FLEXlm. The 
vendor daemon keeps track of how many licenses are checked out and who has them. 
Rational’s vendor daemon (rational.exe) is customized to behave in a specific manner. 

Rational specifies the path to the rational.exe vendor daemon using the DAEMON line 
in the license key file. Rational also supports specifying the path to the options file on 
the DAEMON line after the path to the vendor daemon.

A typical Rational DAEMON line for Windows appears as:

DAEMON rational D:\Rational\common\rational.exe

Where:

Licenses are granted by running processes. There is one process or vendor daemon for 
Rational which has a licensed product on the network.

If the vendor daemon terminates for any reason, all users lose their licenses (They do 
not see a warning dialog box that the vendor daemon has terminated). However, this 
does not mean the applications suddenly stop running. Users can continue working, 
save their work, and exit safely, because the lmgrd (license manager) automatically 
restarts the vendor daemon. 

The application program communicates with the vendor daemon, usually through 
TCP/IP network communications. The application program and the daemon 
processes (the license server) can run on separate nodes on your network, across any 
size wide-area network. 

The format of the traffic between the client and the vendor daemon is 
system-independent, allowing for heterogeneous networks. This means the license 
server and the computer running an application can use different hardware platforms 
or even different operating systems (for example, Windows NT as a server and 
Windows 98 as a client). 

Item in DAEMON Line Description

DAEMON Rational’s license daemon name and path are specified 
in this line. 

rational The name of the Rational license server daemon. Both 
floating and node-locked licenses have this value 
defined in the DAEMON string.

<install path>\
Rational\common\rational.exe

The path to Rational’s license server executable.
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License Server Process

When you run a counted licensed application, such as a Rational Suite product that 
uses a floating license, the following occurs: 

1 The license module in the client application finds the license key file on the license 
server, which lists the hostname of the license server and the port number of the 
license manager daemon (lmgrd.exe). 

2 The client establishes a connection with the license manager daemon (lmgrd.exe) 
and specifies the vendor daemon (rational.exe). 

3 The lmgrd.exe determines which computer and port correspond to rational.exe and 
returns that information to the client. 

4 The client establishes a connection with rational.exe and sends its license request. 

5 The vendor daemon (rational.exe) checks in its memory to see if any licenses are 
available and sends a grant or denial back to the client. 

6 The license module in the application grants or denies use of the feature, as 
appropriate.
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The following diagram provides an overview of the interaction between the Rational 
Common Licensing Library on the client and lmgrd.exe, rational.exe, and the license key 
file on the Rational license server.

The Options File for Floating Licenses

Rational provides the least restrictive licensing environment possible. By default, the 
server does not restrict access to any client requesting a license key. This configuration 
works best for most customers. 

If you want a more controlled floating license environment, you can use the options 
file to reserve or deny licenses for certain users, hosts, displays, groups, or IP 
addresses. You can also limit the number of licenses each user or group can access. 
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Setting Up the Options File

To create an options file:

1 Using a text editor create a text file, rational.opt, in the <rational flexlm dir>\common 
directory. 

2 Enter the following commands in the file. See examples 1 and 2 for the correct 
syntax.

Note:  For the server to recognize the file or any changes made to it, restart the license 
server. You will have to stop and then start the license server. The lmreread 
diagnostic tool will not work. 

Example 1 

You may have 10 floating licenses of Rational ClearQuest. You want to ensure that 
users Greg and Peter always have a license of ClearQuest available for their use. Set 
up the options file as follows:

RESERVE 1 ClearQuest USER greg

RESERVE 1 ClearQuest USER peter

Example 2

You have 10 floating licenses of Rational ClearQuest. You want to ensure that user Bob 
does not have access to a ClearQuest license. Set up the options file as follows:

EXCLUDE ClearQuest USER bob

Options File Commands Description

RESERVE Tells the server to reserve a license

1 Is the number of licenses to reserve

ClearQuest Is the name of the license to reserve

USER Tells the licensing software to reserve a license for a 
specific user id

greg Is the userid for which the license will be reserved
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Diagnostic Tools

lmtools

The lmtools application is designed to help diagnose licensing problems. It is 
available on Windows only. Rational installs this application with all products in the 
<rational>\common directory. If the license server is installed, you can use the License 
Tools Start menu shortcut to the lmtools GUI.

lmutil

By default, Rational installs the lmutil program in the <rational>\common directory. 
lmutil is fully supported with Rational’s implementation and has a number of useful 
options. More information can be found at http://www.globetrotter.com/chap7.htm.

lmreread

The lmutil lmreread command is a supported option that forces the server to source 
the license file without having to shut down the server. This allows systems 
administrators to make changes to the license file without stopping and restarting the 
server.

Note:  The lmutil lmreread command does not detect changes to the Options File 
page 108.

Windows Registry Information

This section describes the Windows Registry settings for Rational Software licensing. 

Warning:  Use extreme caution when editing the Windows Registry! Incorrect edits 
can render your computer unusable!

Windows Registry entries are located in:

HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Licensing\1.0
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The <Install Path> in Table 17 refers to the path specified during installation. The 
default value is C:\Program Files\Rational.

Table 17 Rational Licensing Registry Entries

Key and Description Default Value

UseLicense Server

Is this computer using a license server 
to obtain its license keys?

FALSE

LicenseTemp

Path of temporary license key file

<Install Path>\common\rational_temp.dat

LicensePerm

Path of permanent license key file

<Install Path>\common\rational_perm.dat

ClientInstalled

Does this computer have client software 
installed?

TRUE

ServerInstalled

Is this computer a license server?

FALSE
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12Troubleshooting Licenses
This chapter provides possible solutions based on commonly asked questions and 
error messages. 

The commonly asked questions are sorted into the following topics:

■ Node-Locked Licenses on page 113.

■ License Server and Floating Licenses on page 113.

■ Requesting a License Key on page 114.

■ Moving License Keys on page 114.

■ AccountLink Data Entry on page 115.

■ Host ID on page 115.

■ Upgrades on page 116.

A list of Windows and UNIX error messages and possible solutions are in Table 18 on 
page 118 and Table 19 on page 120.

Node-Locked Licenses

Does a change in the IP address and internet address affect the node-locked 
license?

Node-locked licenses use the host ID (disk_serial_num) or ethernet address of the 
licensed computer. Therefore, a change in the IP address or a change in Internet 
address does not affect your Rational Software license. However, you should notify 
Rational Licensing Support if the e-mail address of the license contact has changed.

License Server and Floating Licenses

Can ClearQuest on a client in one Windows domain obtain licenses from a 
license server that is on a different Windows domain?

Yes, it is possible. If the client can see the license server by hostname, the request will 
work. Rational licensing also supports using the fully qualified domain name or using 
the IP address of the license server instead of the hostname.
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How do I install licensed software on a second disk? I have a second disk on my  
computer and I have requested a floating license for <product>. 

Provide the correct hostname, hostid, and Rational account number for the second 
disk in AccountLink. Then install the software on the second disk and import the 
permanent license key that you receive from AccountLink on the second disk.

How do I restart my master license server? I have redundant servers and I 
cannot restart my master server.

To restart a server in a redundant server configuration, restart all the servers in no 
particular order. You cannot just restart the server that has gone down. 

Requesting a License Key

Can we request permanent license keys without entering a temporary key?

Yes, you can use AccountLink (http://www.rational.com/accountlink) to request permanent 
license keys without first installing your temporary license key.

How long does it take to obtain the permanent license key? 

Rational AccountLink (http://www.rational.com/accountlink) will send you the license 
keys through e-mail after you submit your transaction. The speed and reliability of 
your internet connection will affect when you will receive your permanent keys.

Moving License Keys

How long does it take to move a license key to another computer?

The requests for returning and getting a new license key usually take no longer than 
your initial license request.

How do I move a node-locked license mistakenly installed on a 
database/repository server to a client? We purchased two node-locked licenses 
for two client computers. I made a mistake and requested and installed one of 
the licenses on the database/repository server. I cannot install this license on 
the second client because it is system-specific.

To move and return license keys, see Returning or Moving Keys for Administrators on 
page 101.
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AccountLink Data Entry

What is my Rational Account Number? I just downloaded the upgrade to 
<product>. I am now unable to run the software. I do not know my “Rational 
Account Number” which is a required field in AccountLink. 

Use the Rational Account number specified on your License Key Certificate. If you 
cannot find your License Key Certificate, contact Rational licensing support with your 
purchase order or sales order number. See Contacting Rational Licensing Customer 
Support on page xvi for phone numbers.

Host ID

What should I do if I need to reformat the hard drive on my computer? 

You need to replace your license keys in case the host id changes on your computer 
during the reformat.

1 Return your license keys to Rational. Go to AccountLink 
(www.rational.com/accountlink). 

2 Perform the reformat. 

3 Order new license keys from Rational through AccountLink. 

What should I do if I am upgrading my OS on my computer? 

If you do not need to reformat your hard drive to do the upgrade, your licenses stay 
on your computer in the Rational/Common directory. After you perform the upgrade, 
all of your licenses should still be available. If you need to reformat the disk, see the 
previous question in this section. 

What if my license .dat files get deleted? 

Go to AccountLInk (www.rational.com/accountlink) and get copies of the license files.

Why isn’t host ID ffffffff valid? ffffffff is the value listed in the host ID field in the 
License Manager.

When you initialized your disk, your disk did not receive a disk_serial_num. 
Although the software accepted this entry, Rational's licensing services regards this 
value as invalid. 

You can reset your host ID by using third-party disk utility tools such as those by 
Norton. Another option is to use the Ethernet card address instead of the host ID.
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I changed my file system from FAT to NTFS, which changed my host ID. Could 
you please change my key to make it work again? I changed my system disk 
and the licenses no longer work. 

The license keys are generated for a specific hostname and host ID. You have to return 
the license keys to your Rational account and then request license keys for the new 
host ID. To perform these transactions, go to AccountLink 
(http://www.rational.com/accountlink).

Upgrades

We received two upgrade packets but chose not to upgrade immediately 
because we were in the middle of pre-release testing. The License Key 
Certificate says, however, that the key expires on <date>. 

Contact your Rational Sales Office to obtain temporary license keys that will work 
until you are ready to upgrade your computer.
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Error Messages

Table 18 and Table 19 explain licensing error messages for Windows and UNIX, 
respectively.
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Table 18 Licensing Error Messages (Windows)

Message or Description Action

■ Cannot find SERVER hostname
■ Cannot find SERVER hostname in 

network database
■ Cannot connect to SERVER
■ NO SUCH FEATURE EXISTS
■ Failed to check out a 

<product-name> key

Floating Licenses

Confirm on the desktop:
■ You have entered the correct name for the 

license server (in the Client/Server 
Configuration dialog box of the License Key 
Administrator). For more information, see 
Checking the Windows Client Configuration on 
page 123.

■ You have entered the correct Rational vendor 
port number if there is a fire wall between the 
client and the license server. For more 
information, see Using Floating Licenses with a 
Firewall on page 78.

■ The network connection between the client and 
the license server is working. For more 
information, see Checking the Windows Network 
Connection on page 122.

Confirm on the Rational license server:
■ The license server (lmgrd) and the rational.exe 

or vendor daemon are running. See Checking the 
Windows License Server on page 121.

■ There are numbers assigned to the lmgrd and 
vendor ports on the license server (if there is a 
fire wall between the license server and the 
client). For more information, see Using Floating 
Licenses with a Firewall on page 78.

Floating and Node-Locked Licenses

In all cases, if you do not see any problems with the 
network connection or the license file, yet 
applications cannot acquire license keys, stop and 
start the license server from the License Manager 
(See Starting the Rational Windows License Server on 
page 71). It may also be helpful to reboot the server, 
particularly if the license manager is running as an 
NT service. If all else fails, contact Rational 
Technical Support.
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The license was not intended for this 
server.

License keys are not for this 
machine.

■ You are installing the license key on a computer 
other than the one for which the license key was 
generated. The license.upd file specifies the 
computer name and host ID that you entered in 
the license key request to Rational 
(AccountLink). Import the file on the correct 
computer.

■ Confirm that the license key file you received 
contains the correct hostid and hostname of the 
license server or client. To find this information, 
use a text editor to view the license key (*.dat) 
file in <Install Path>\Rational\Common\. 

Compare the Disk Volume Serial Number found in 
License Tools > System Settings, with what 
appears in the Server line in the license key file. 
These two numbers should match. Occasionally 0 
or a dash will be found in the license file. 

The license for this product will 
expire…

Your temporary or Term License Agreement (TLA) 
license key is nearing its expiration date. To 
continue using the product, contact your Rational 
Software sales representative to purchase the 
product or extend your TLA. 

Click OK to run the product.

This warning message appears each time you start 
the application until you install a permanent license 
key or another TLA license key. 

You can turn off the warning by clicking Settings  
> Display Expiration Warnings in the Rational 
License Key Administrator.

Table 18 Licensing Error Messages (Windows) (continued)

Message or Description Action
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Table 19 Licensing Error Messages (UNIX)

Message Explanation/Action

There is a problem with one license 
key.

or

There are problems with <N> 
license keys.

This means that the license keys in the license file do 
not match and are inconsistent with the text of the 
license. The licenses consist of several parameters and 
a 12-digit hexadecimal key that was created using 
these parameters. The parameters are in ASCII text but 
they cannot be changed or it will invalidate the license. 
The parameters used to create the license are the 
server host ID, license name, vendor daemon name, 
expiration date, number of users (quantity), 
VENDOR_STRING, OVERDRAFT, SUPERSEDE, 
DUP_GROUP, and NOTICE.

You do not have remote access to 
<license-server-name> from 
<local-host-name>, so it cannot be 
set up as a license server...

It may be that the license server is not the same 
computer on which you are installing. You must 
have remote shell access (rsh or remsh) to the 
license server.

Host <license-server-name> is 
running Solaris.

Host <local-host-name> is running 
HP-UX.

They do not match so 
<license-server-name> cannot be 
used as a license server.

It may be that the license server is not the same 
computer on which you are installing. If so, it must 
run the same operating system that the product you 
are installing requires.

Host, <license-server-name> does 
not have access.

If the license server is not the same computer on which 
you are installing, it must have access to the 
rational_dir directory where Rational products have 
been installed.

Cannot set <license-server-name’s> 
host ID with this command: 
rational_dir/base/cots/flexlm.7.0f/
lmhostid

The lmhostid command failed. Check to see if the 
lmhostid command shown will run on your local 
host. If so, enter the host id number in the License 
Server Host ID Menu (choice number 2).

Cannot access 
rational_dir/base/cots/flexlm.7.0f/
lmhostid on <license-server-name>.

There was a problem accessing the rational_dir 
directory or the lmhostid command was not 
installed from the CD-ROM.

Host ID <nnn> not valid. Less than 4 
digits.

This means that the host ID number will not 
work. Check again using the lmhostid to see what 
the host ID is. It should be at least four or more 
hexadecimal digits.
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Checking the Windows License Server

Use the following procedure to determine whether one or both of the license 
daemons, lmgrd.exe and rational.exe, is not working.

1 Click Start > Programs > Rational License Server > License Tools. This brings up 
lmtools, a FLEXlm utility that is a GUI version of the command line utility lmutil.

2 In the Service/License File tab, select Configuration using License File and enter the 
complete path (including drive letter) to the license file on the license server in the 
text box.

3 Go to the Server Status tab. Select Display Everything and click Perform Status 
Inquiry button.

a If the license server is running, you will see the following lines in the status 
output window:

server_hostname: license server UP (MASTER) v_number

Vendor daemon status (on server_hostname): 
rational: UP v_number

The first line refers to the status of lmgrd.exe, the second line to the status of 
rational.exe.

Since the Rational license server software is running, the problem may be the 
network communication between client and server. See Checking the Windows 
Network Connection on page 122.

b If lmgrd.exe is running, but rational.exe is not, the following lines will appear in 
the status output window:

server_hostname: license server UP (MASTER) v_number

Port number <pn> is in use in 
/etc/services.

or

Port number <pn> is in use under 
NIS services.

If you entered a port number and it appears that the 
number is in use in your /etc/services file or under 
NIS services, you may have a problem with 
licensing.
Rational products use FLEXlm which uses TCP/IP 
sockets to communicate with a license server using a 
specific port number. This port number is specified in 
the license file on the SERVER line. The license server 
will not be able to open a socket on a port that is 
already in use. Rational recommends that you use the 
default port number, 27000.

Table 19 Licensing Error Messages (UNIX)

Message Explanation/Action
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Vendor daemon status (on server_hostname): 
rational: The desired vendor daemon is down.

Use the following methods to start the rational.exe:

❑ The daemon rational was unexpectedly terminated and lmgrd has not yet 
restarted it. Select the Stop/Reread tab in the License Tools utility. Expand the 
Remote Server List and select rational. Click the Reread License File button. 

❑ The license file does not correctly specify the path to rational.exe in the line: 
DAEMON rational [complete path to rational.exe, including drive letter].

❑ The version of lmgrd.exe may be incompatible with rational.exe. You already 
have FLEXlm (lmgrd.exe) installed on the license server. Confirm that the date 
and size of the file install_directory\common\lmgrd.exe matches the lmgrd.exe found 
in the \common directory of the Rational Solutions for Windows CD-ROM.

c If both lmgrd.exe and rational.exe are not running, the resulting status output 
window will contain the lines:

lmgrd is not running: Cannot connect to server 
FLEXlm error: -15.10.

Use the following methods to start the lmgrd.exe and the rational.exe:

❑ Review the setup and start instructions for the Rational license server.

❑ There may be a phantom "rational" process running. This occurs when the 
lmgrd process is terminated unexpectedly. Press CTRL-ALT-DEL to bring up 
the Task Manager. On the Processes tab, look for rational.exe and/or lmgrd.exe. 
Terminate these processes. Start the license server (see Starting the Rational 
Windows License Server on page 71) and check the Server Status in Rational 
License Server > License Tools. If the license server is still not running, and it is 
configured to run as an NT service, restart the computer twice.

❑ The FLEXlm License Manager application may be out of date or corrupted.

Checking the Windows Network Connection

The following procedures lets you check the network connection between the license 
server and the client.

1 On the client, bring up an MS-DOS window by clicking Start > Run and typing cmd 
in the Open text box. 

2 Type ping server_hostname at the command prompt.

If you see an IP address appear, a computer of that hostname has responded. There 
may be more than one computer on the network with the same hostname. To make 
sure the IP address that you see in the Window is the server’s IP address, check the 
IP address of the server.
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To find the IP address of the license server:

a Go to your Rational license server and click Rational License Server > License 
Tools. 

b Click the System Settings tab in the LMTools dialog box. 

c Check the IP address under Hostid Settings.

If you cannot ping the license server by hostname, ping it by its IP address. If this 
is successful, you will have to either correct the name resolution problem on your 
network or replace the hostname with the IP address in the license key file.

To replace the hostname in the license key file:

a In install_directory\Rational\common of the license server, look for the file 
rational_server_perm.dat.

b Replace the hostname with the IP address in the line that begins with SERVER:

SERVER server_hostname server_hostid...

Do not change the server_hostid and the vendor daemon information on 
this line.

c Enter the IP address of the server in the LKAD’s Settings > Client/Server 
Configuration dialog box. 

Checking the Windows Client Configuration

The following list lets you check whether the client is correctly configured for Rational 
Common Licensing.

■ Check the entry or entries for the license server(s) in the Client/Server Configuration 
dialog box of the desktop’s LKAD. If you are unsure about the format in which the 
server hostname should be entered, go to your Rational license server and click 
Rational License Server > License Tools. This brings up LMTools, a FLEXlm utility 
that is a GUI version of the command line utility lmutil. 

Click the System Settings tab in the LMTools dialog box. Check the entry next to 
Computer/Hostname under Hostid Settings.

■ In the client’s Windows registry, look under 
HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\Licensing\1.0. The value 
"Serve List" should have the server hostname. 
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Technical Notes

The Rational Web site contains technical notes about additional licensing issues. New 
technical notes appear on a regular basis. To find the technotes, go to 
http://www.rational.com. 

1 Select Support > Support Overview. 

2 Under Finding Answers, click Knowledge Base.

3 You can search for licensing topics in the Search Solutions search engine.
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Glossary
A
AccountLink. The Rational Web-based license management tool. Customers can use this tool to request 
permanent license keys and return license keys to their Rational accounts.

ANY-HOST. A license key issued for ANY-HOST will run on any computer and is not tied to the 
customer's computer ID. Evaluation, Temporary and Emergency Keys must be configured to run on any 
computer.

E
Evaluation Key. A temporary key that lets a customer use and evaluate Rational software for a fixed 
period of time. Rational Software determines the duration of the Evaluation Key. Evaluation Keys can be 
node-locked or floating. Evaluation Keys are distributed by the Rational sales team or the Tryit Center on 
rational.com. They run on any host.

F

Floating License. A license type that links products to a license server. Client computers obtain licenses 
from the license server when they need to run a copy of Rational software. Multiple clients can share the 
pool of floating licenses; one license is granted per client per product. Floating licenses on license servers 
are typically administered by system administrators.

K
Key Type. Node-locked and floating licenses can be enforced by different types of license keys. The 
types of license keys are temporary and permanent. Evaluation and emergency keys are variations of 
temporary keys. Term License Agreements (TLAs) are a variation of permanent keys. Each type of key 
has different business rules and policies.

L
License. A legal right to use a product. Customers receive licenses when they purchase Rational 
products. However, they need license keys either on a license server or on desktops to actually run the 
products.

License Key. Generic term used in this document to describe keys that enable licenses on a customer 
computer. The types of license keys are: permanent, temporary, evaluation, emergency, and Term License 
Agreement (TLA).
125



License Key Administrator. A program written by Rational Software which provides a customer 
interface to Rational's Licensing system. The License Key Administrator is installed whenever a Rational 
software product is installed on a Windows computer. For hosting floating licenses, the License Key 
Administrator is installed when the Rational license server software is installed on a computer.

License Key Certificate. A piece of paper or an electronic file that contains information a customer needs 
to begin using Rational software with a license.

License Key Code. An encrypted code used to enforce a license agreement.

License Type. The valid types of licenses are node-locked licenses and floating licenses. See also Key 
Type.

LKAD. Abbreviation for License Key Administrator.

N
Named-User Floating. Similar to a floating license type, except the license administrator assigns licenses 
to specific users. That is, only specific users can request floating license keys from the license server. This 
license type is only available to customers who purchase Purify, Quantify, and PureCoverage.

Node-Locked License. A type of license that links a product to a computer. Typically, one node-locked 
license is issued for each software copy.

P
Permanent Key. A license that lets customers run Rational products indefinitely. Permanent keys can be 
node-locked or floating. Node-locked permanent keys are installed on a client desktop. Floating 
permanent keys are installed on a license server. Note: A Term License Agreement, a variation of a 
permanent key, does have an expiration date. See Term License Agreement.

Permanent Key Code. The encrypted code that lets a customer run a particular Rational product using a 
Permanent Key. 

T
Temporary Key. A short-term license key that lets a customer run Rational software products. 
Temporary licenses are not keyed to a specific computer. Temporary Keys can be node-locked or floating. 
Node-locked Temporary Keys are installed on a desktop. Floating Temporary Keys are installed on a 
license server. Temporary Keys run on any host until the specified expiration date.

Temporary Key Code. The encrypted code that lets a customer run a particular Rational product using a 
Temporary Key. 

Term License Agreements (TLAs). Variation of a Permanent Key. TLAs are issued to a site to let their 
employees use Rational software for a negotiated period of time. 
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U
User. Rational Common Licensing checks out licenses on behalf of a “user”. The “user” is defined as 
follows:

■ On Windows, the “user” is the Windows operating system log on ID.

■ On UNIX, a “user” is the account name of the person running the UNIX shell.

■ On Web products, the “user” is the product logon ID.
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importing permanent license keys

floating 59, 68
License Key Administrator 22
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node-locked 26, 59

installing license server
UNIX 85
Windows 65
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IP address 113

L
license agreement 66
license files. See license keys
License Key Administrator

accessing 23, 44, 67
command line syntax 33, 72
configuring licenses 44, 45
definition of 126
entering server name 105
importing license keys 26, 68
opening 22

License Key Certificate 43
license key types

permanent 48
temporary 48
Term License Agreement (TLA) 48

license keys
combining 43
definition of 104
deleting. See returning license keys
file names 104
moving 37, 96, 102
opening the LKAD 22
receiving 58
requesting 114
server line 105
upgrading 51

license manager (lmgrd)
commands 95
daemon 80, 103, 105

license monitoring 78
license order. See license usage order
license servers (UNIX)

components, description of 103
documentation 81
floating licenses 82, 85
installing software 84
named-user floating licenses 83
port number 121
processes, description of 107
redundant 88
removing software 98
requirements 84
restarting 87
troubleshooting 120

license servers (Windows)
components, description of 103
configure Web servers 75
floating licenses 62, 68
installation path 66
installing software 65
linger time 76
named-user floating licenses 63
processes, description of 107
redundant 77
removing software 80
requirements 65
running multiple servers 64
specifying server in text file 73– 74
starting 71
technical notes 124
time-out period 76
troubleshooting 64, 113, 118– 119, 121
upgrading 64

license types
floating 46
named-user floating 47
node-locked 47

license usage order
Clearquest Web 35
description of 36
RequisiteWeb 35
Rose 35

licensing components, location of 103
licensing configurations 52
linger time 76
LKAD command line 33, 72
lmgrd port 80
lmgrd. See license manager daemon
lmtools 78
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M
manual start-up 71
mapper, license usage. See license usage order
monitoring licenses 78
moving license keys 97, 102, 114

N
named-user floating licenses

description of 69
setting up on UNIX 83
setting up on Windows 63

network connection, Windows 122
networking configurations

dial-up support 64
Novell support 65
WAN support 65

node-locked licenses
description of 47
installing 21, 26
internet address 113
IP address 113
permanent keys, importing 26
reviewing license information 25, 30
temporary keys, entering 27

Novell support 65
NTFS 116

O
options file 69, 70, 108

P
permanent license keys

floating 68, 85
moving 102
named-user floating 69, 87
node-locked 26
returning 101

platform support
UNIX license servers 84
Windows license servers 65

point product licenses 48

ClearCase LT 49
ClearQuest Web 49
RequisiteWeb 49
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post-installation commands, specifying 72
prioritizing licenses. See license usage order

R
Rational Common Licensing
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Rational Developer Network xiv
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configure Web servers 75
configure Windows clients 31
setting up on UNIX 88
setting up on Windows 77

removing
license keys. See returning license keys
UNIX license server 98
Windows license server 80

requesting license keys 114
AccountLink 55
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RequisiteWeb
license usage order for 35
user id 49

returning license keys 55, 96, 101– 102
Rose

keys for different platforms 50
license usage order for 35
variant keys 49

S
specifying post-installation commands 72
start script 92
start-up 71
stopping disconnected mode 34, 52
suite licenses 49
suitemap. See license usage order
supported licensing configurations 52
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named-user floating 70
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host id 115, 120
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redundant 88
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restarting 87
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upgrading
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Windows license server 64

V
vendor daemon 103

W
WAN support 65
web-based training xiv
Windows
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registry 110

Windows license server
configure Web servers 75
floating licenses 62, 68
installation path 66
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linger time 76
named-user floating licenses 63
redundant 77
removing 80
requirements 65
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